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CAUTION!

xStream is a sophisticated gas transient modeling program designed for qualified
engineers with experience in transient analysis and should not be used by
untrained individuals. xStream is intended solely as an aid for pipe flow analysis
engineers and not as a replacement for other design and analysis methods,
including hand calculations and sound engineering judgment. All data generated
by xStream should be independently verified with other engineering methods.

xStream is designed to be used only by persons who possess a level of
knowledge consistent with that obtained in an undergraduate engineering course
in the analysis of pipe system fluid mechanics and is familiar with standard
industry practice in transient analysis.

xStream is intended to be used only within the boundaries of its engineering
assumptions. The user should consult the xStream Help System for a discussion
of all engineering assumptions made by xStream.

Information in this document is subject to change without notice. No part of this Quick Start
Guide may be reproduced or transmitted in any form or by any means, electronic or mechanical,
for any purpose, without the express written permission of Applied Flow Technology.

© 2025 Applied Flow Technology LLC. All rights reserved.

“AFT xStream”, “AFT Arrow”, “Applied Flow Technology”, “Dynamic solutions for a fluid
world”, “Pulsation Frequency Analysis”, and the AFT logo are trademarks of Applied Flow
Technology LLC.

Excel and Windows are trademarks of Microsoft Corporation. Chempak is a trademark of Madison
Technical Software, Inc. REFPROP is a trademark of the National Institute of Standards and
Technology (NIST). CAESAR II, Smartplant, CADWorx, and PDS are trademarks of Intergraph
Corporation / Hexagon AB. ROHR2 is a trademark of SIGMA Ingenieurgesellschaft mbH.
AutoCAD Plant 3D is a trademark of Autodesk, Inc.
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C H A P T E R 1

Introducing xStream

Welcome to xStream, Datacor’s powerful gas transient modeling tool. With
xStream you can model transients caused by a wide range of pipe system
behavior. This tool will allow you to understand transient pressure extremes.

xStream includes a steady-state solution engine which solves for the system’s
initial conditions. These results are used to assist with initializing the transient
model.

xStream has one available Add-on Module for purchase which extends the
modeling capabilities into new areas.

� The Pulsation Frequency Analysis (PFA) module allows the engineer to
determine resonant frequencies that can result in excessive vibration and
damage to systems.

Modeling capabilities

Standard version capabilities
� Transients in open and closed (recirculating) systems

� Network systems that branch or loop

� Systems with valve transients

� Systems with compressor transients

� Heat transfer analysis and system energy balance

� Systems with non-ideal gases

� Systems that experience sonic choking, including multiple sonic choking
points and transient sonic choking

� Multiple design cases in a single model file

Add-on module capabilities (optional)
� Identification of natural acoustic frequencies (PFA)

� Evaluation of pressure results with API-618 (PFA)
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Engineering assumptions in xStream

xStream is based on the following fundamental fluid mechanics assumptions:
� Compressible flow

� One-dimensional flow

� System is fluid-full

� All gases are superheated (single phase)

� No chemical reactions

� No supersonic flow in the system

� Pipes are rigid (pipe geometry does not change during the transient)

The Steady-State Solver

Before a transient model can be run, the initial steady-state conditions are
required. xStream obtains the steady-state solution using multiple stages. First,
the Solver from Arrow, Datacor’s steady-state compressible flow modeling
software, is used to calculate the steady solution to initialize the second stage.

Second, the Transient Solver is run with user-specified transients disabled. The
Arrow Solver will typically have slight differences from the Transient Solver,
and the Transient Solver must be run to find a new steady solution to avoid
introducing artificial transients into the transient analysis. This solution is run in
a series of time step blocks. After each block, the velocity results from the
beginning and end of the block are compared to determine if the results are
sufficiently steady.

If desired, xStream can be run in Arrow Steady mode where only the steady
flow pipe pneumatics are modeled. When run in Transient mode, the steady flow
solution is used to assist with initializing the transient solution. This convenience
helps the user avoid the often error-prone process of manually setting up the
initial conditions, ensures the solution is steady before the transients are run, and
allows the user to quickly and safely modify and rerun the model as needed.

The Transient Solver

xStream employs the Method of Characteristics (MOC) to solve the transient
equations of gas flow. The fundamental mass, momentum, and energy equations
are solved at all computing stations in each pipe to accurately represent the
propagation of transient waves throughout the system.

The MOC is an explicit solution technique, where the Transient Solver marches
in time for a duration specified by the user.

2 xStream 4 Quick Start Guide



Thermophysical property data

xStream offers several sources from which thermophysical properties can be
derived:
� ASME Steam Tables - Properties are calculated with the equations of state

from the IAPWS Industrial Formulation (1997), also used to generate the
ASME steam tables.

� Chempak™ - Optional add-on for purchase which contains data for
approximately 600 gases and supports user-specified fluid mixtures.
Chempak is licensed from Madison Technical Software.

� NIST REFPROP - The Reference Fluid Thermodynamic and Transport
Properties Database is licensed from the National Institute of Standards and
Technology (NIST) where properties for approximately 150 fluids are
calculated via equations of state. REFPROP supports user-specified fluid
mixtures.

� xStream Standard - Common fluids from various industry standard sources
have been curve fit to optimize calculation speed.

� User Library Fluid - A custom fluid can be saved to the User Library for
repeated use in the future.

xStream Primary Windows

xStream has several Primary Windows that work in an integrated fashion. Each
is located on a separate, moveable tab. You work exclusively from one of these
windows at all times. For this reason, they are referred to as Primary Windows.

Workspace
The Workspace Primary Window is where the user creates the graphical
representation of the system. Engineering data is input on pipe and junction
property windows which are opened by double-clicking the objects.

The Workspace Layers are also located on this Primary Window and allow the
user to display both input and output data superimposed on the pipe system
schematic.

Model Data
The Model Data Primary Window summarizes the engineering input data from
the Workspace into categorized tables. This allows for easy review of the system
inputs, and double clicking cells will open the pipe or junction properties for
quick editing.
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Output
The Output Primary Window offers a powerful and diverse range of features for
reviewing analysis results which are organized into categorized tables and lists.
The Output allows the user to easily compare multiple design scenarios with
color coded rows, details errors or design requirement violations, and prepare
the results for documentation.

Graph Results
The Graph Results Primary Window allows the user to create a wide array of
graphs with various parameters which are integral to gaining a deeper
understanding of the pipe system’s behavior. The user can adjust various
formatting settings such as axis ranges, labels, colors, and create dual y-axis or
stacked graphs. The settings can be saved into templates called Graph List Items
so that the graphs can be easily reproduced.

Input vs. Output
Table 1.1 summarizes how each Primary Window relates to input and output
data. The Workspace can display output data by using Workspace Layers after
the simulation has been run.

Table 1.1 Primary Window Input vs. Output Data

Primary Window Can Display Input Can Display Output

Workspace ✓ ✓

Model Data ✓

Output ✓

Graph Results ✓

Note: xStream supports multiple monitors. You can click and drag any of the
Primary Window tabs off of the main xStream window, where it can then be
moved anywhere on the screen, including onto a second monitor. To add the
Primary Window back to the main xStream program window bar, simply close
the Primary Window.

Note: To ensure that your results are the same as those presented in this
documentation, these examples should be run using default settings, unless you
are specifically instructed to do otherwise.
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C H A P T E R 2

Tank Blowdown Example

Problem Statement

This example will give you the big picture of xStream’s layout and structure. To
accomplish this purpose, a simple model will be built to evaluate the initial
design for a tank that undergoes a blowdown. Nitrogen flows out of a supply
tank into a 2 inch line as a part of the blowdown. The flow is controlled by
opening and closing a valve in the 2 inch line. This model will simulate opening
the valve in 0.1 seconds, after which the valve will remain open for the
remainder of the simulation.

Graph the pressure and temperature of the tank to observe how both parameters
change with time. Also, graph the Mach number, temperature, and velocity at
the discharge of the second pipe to understand how the flow properties change
as the blowdown progresses.

Topics Covered
� Model building basics

� Entering Pipe and Junction data

� Entering transient data

� Using the Primary Windows: Workspace, Model Data, Output, & Graph
Results

� Analysis Setup: fluid libraries, sectioning pipes, etc

� Graph types

� Workspace Layers

Required Knowledge

No prior knowledge is required for this example.
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Model File

This example is intended to be built from scratch to help familiarize yourself
with the steps to define a complete model in xStream. For reference purposes
only, the completed example model file can be found in the Examples folder as
part of the xStream installation:

C:\Users\[username]\Documents\Datacor\xStream 4\Examples
� Metric - Beginner - Tank Blowdown.xtr

Step 1. Start xStream
► To start xStream, open the all applications list in the Windows Start Menu,

expand the xStream 4 folder, and choose xStream 4 to launch the application.
This refers to the standard menu items created by a standard installation.

As xStream starts, the Startup Window appears, as shown in Figure 2.1. This
window provides you with several options before you start building a model.

Figure 2.1 Startup Window with Modeling Preferences collapsed

Some of the actions available from the Startup window are:
� Open a previous model, browse to a model, or browse to an example

� Activate an Add-on Module

� Select xStream Standard “Air” or a recently used fluid to be the Working
Fluid
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� Review or modify Modeling Preferences: select a Unit System, filter units,
choose a Grid Style, select a Default Pipe Material, and more

� Access other Resources such as Help Files and Video Tutorials

If this is the first time that you have started xStream, Modeling Preferences will
be expanded in the middle section of the Startup Window, as shown by Figure
2.2. If this is not the first time that you have started xStream, the Startup
Window will appear with Modeling Preferences Collapsed, as shown in Figure
2.1.

When collapsed, you can view your current Modeling Preferences at the bottom
of the Start a New Model section. To further review or adjust your preferences,
click the Modify button (Figure 2.1).

Figure 2.2 Startup Window with Modeling Preferences expanded

► With Modeling Preference expanded, as in Figure 2.2, select Both with
Metric Defaults under Unit System. The Filter section can be used to limit the
number of units that are shown in the interface.

The Common Plus Selected Industries option adds units from the industries you
select. You can use the Show Sample Units option to see the model units based
on your selections. After modifying your Modeling Preferences, click
Remember My Preferences and Hide.

► Click Start Building Model.

The Workspace window is shown initially, as seen in Figure 2.3. The tabs in the
xStream window represent the Primary Windows. Each Primary Window

7 xStream 4 Quick Start Guide



contains its own toolbar that is displayed directly beneath the Primary Window
tabs.

xStream supports multiple monitor usage. You can click and drag any of the
Primary Window tabs off of the main xStream window, where you can then
move it anywhere you like on your screen, including onto a second monitor in a
dual monitor configuration. To add the Primary Window back to the main
xStream window bar, simply click the "X" button in the upper-right of the
primary window.

To ensure that your results are the same as those presented in this
documentation, this example should be run using all default xStream settings,
unless you are specifically instructed to do otherwise.

The Workspace window
The Workspace window is the primary interface for building your model. This
window has three main areas: the Toolbox, the Quick Access Panel, and the
Workspace itself. The Toolbox is the bundle of tools on the far left. The Quick
Access Panel is displayed on the far right. It is possible to collapse the Quick
Access Panel by clicking on the thumbtack pin in the upper-right of the Quick
Access Panel in order to allow for greater Workspace area.

Figure 2.3 The Workspace Primary Window

You will build your model on the Workspace using the Toolbox. The Pipe
Drawing tool on the upper-left is used to draw new pipes on the Workspace. The
Annotation tool beside it allows you to create annotations and auxiliary graphics.

Below the two drawing tools are the different types of junctions available in
xStream. Junctions connect pipes and also influence the pressure or flow
behavior of the pipe system. Drag and drop any of the junction icons from the
Toolbox to add them to the Workspace.

Holding your mouse pointer over a Toolbox icon identifies the tool’s function.

8 xStream 4 Quick Start Guide



Hiding the Quick Access Panel
By default, the Quick Access Panel is pinned to the Workspace window so that
it is always displayed. The Quick Access Panel can be unpinned so it is only
displayed when the mouse is moved over the tab displayed on the right edge of
the Workspace window. You can unpin the Quick Access Panel by clicking on
the pin icon displayed in the top-right corner of the Quick Access Panel (Figure
2.3). The Quick Access Panel will be pinned for the remainder of the examples
in this guide.

Step 2. Build the model

To lay out this example model, you will place several junctions on the
Workspace. Then, you will connect the junctions with pipes.

A. Place the Tank junction
► To start, click and drag a Tank junction from the Toolbox and drop it on the

Workspace. Figure 2.4a shows the Workspace with one Tank.

Objects and ID numbers
Items placed on the Workspace are called objects. All objects are derived
directly or indirectly from the Toolbox. xStream uses three types of objects:
pipes, junctions, and annotations.

All pipe and junction objects on the Workspace have an associated ID number.
Junctions are prefixed with the letter J, and pipes are prefixed with the letter P.
You can assign a name in the object’s Properties window, and the visibility of
both the name and ID number can be controlled through the use of Workspace
Layers. You can also drag the ID number/name text to a different location to
improve visibility.

The Tank you have created on the Workspace will take on the default ID
number of 1. You can change this to any desired integer between 1 and 99,999
that is not already assigned.

Editing on the Workspace
You can move junctions on the Workspace to new locations. You can also cut,
copy, paste, and duplicate junctions from the Edit menu or using keyboard
shortcuts. Undo is available for most arrangement actions on the Workspace.

Note: The relative location of objects is not important. Pipe lengths and junction
elevations are defined through property windows. The relative object locations
on the Workspace establish the connectivity of the objects but have no bearing
on the actual length or elevation relationships.
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Figure 2.4a Tank junction placed

B. Place the other junctions
► Drag a Valve and an Assigned Pressure junction from the Toolbox and
drop them on the Workspace so that your model appears similar to Figure
2.4b. The Valve will be assigned the default number "J2", and the Assigned
Pressure junction will be assigned the default number "J3".

The calculations will not be affected if the icons do not line up exactly. You can
align the icons by using the Align feature selected from the Arrange menu.

Figure 2.4b All junctions placed

► Before continuing, save the work you have done so far by either choosing
Save As... from the File menu, clicking the Save button on the Common
Toolbar, or using the CTRL+S keyboard shortcut. Enter a file name (Tank
Blowdown, perhaps) and xStream will append the *.xtr extension to the file
name.

C. Draw a pipe between J1 and J2
Now that you have all of the junctions placed, you need to connect them with
pipes.

10 xStream 4 Quick Start Guide



► To create a pipe, click the Pipe Drawing Tool icon on the Toolbox. The
pointer will change to a crosshair when you move it over the Workspace. Draw
a pipe near the junctions by clicking and dragging the mouse, similar to that
shown in Figure 2.4c.

The pipe object on the Workspace has an ID number (P1) that is shown near the
center of the pipe.

Figure 2.4c First pipe drawn

► To place the pipe between J1 and J2, use the mouse to grab the pipe in the
center and drag it so that the left endpoint falls within the J1 Tank icon, then
drop it there (see Figure 2.4d). Next, grab the right endpoint of the pipe and
stretch the pipe, dragging it until the endpoint terminates within the J2 Valve
icon (see Figure 2.4e).

Figure 2.4d First pipe partially connected
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Figure 2.4e First pipe fully connected

D. Add the remaining pipe
A faster way to add a pipe is to draw it directly between the desired junctions.

► Activate the Pipe Drawing Tool again. Position the cursor on the J2 Valve,
then press and hold the left mouse button. Stretch the pipe across to the J3
Assigned Pressure junction, then release the mouse button. All objects in the
model should now be graphically connected as they are in Figure 2.4f.

Save the model by selecting "Save" in the File menu, by clicking the "Save"
icon on the Toolbar, or by entering CTRL+S.

Figure 2.4f All pipes and junctions placed

Reference positive flow direction
The arrow on each pipe indicates the reference positive flow direction for the
pipe. The direction does not influence the direction that the flow may go, it
influences sign convention only. If the direction of flow calculated by the Solver
is the opposite of this reference flow direction, then the output will show the
flow rate as a negative number.
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You can reverse the reference positive flow direction by choosing Reverse
Direction from the Arrange menu, selecting the Reverse Pipe Direction button
on the Toolbar, or pressing F3.

Although the reference positive flow direction does not need to point in the
direction of the actual flow, when used with compressors, the reference direction
determines the suction side and discharge side of the compressor.

Note: Examples of other junctions that depend on pipe directions include
Control Valves, Check Valves, and Area Changes.

Note: Some users find it desirable to lock objects to the Workspace once placed.
This prevents accidental movement and disruption of the connections. You can
lock all the objects by first selecting all objects by using CTRL+A or the Edit
menu by clicking Select All. Then use CTRL+L or go to the Arrange menu and
selecting Lock Object. The lock button on the Workspace Toolbar will appear
depressed, indicating it is in an enabled state. Alternatively, you can use the grid
feature and snap to grid. The grid options can be modified through the Arrange
menu or User Options window.

Step 3. Define the model components

The model must have all pipes and junctions defined in order for it to run. This
step encompasses the proper input data and connectivity for all pipes and
junctions.

Object status
Each pipe and junction has an object status. The object status tells you whether
the object is defined according to xStream's requirements. To see the status of
the objects in your model, click the light bulb icon on the Workspace Toolbar
(alternatively, you could choose Show Object Status from the View menu). Each
time you click the light bulb, Show Object Status is toggled on or off.

When Show Object Status is on, the ID numbers for all undefined pipes and
junctions are displayed in red on the Workspace. Objects that are completely
defined have their ID numbers displayed in black. These colors are configurable
through User Options from the Tools menu.

Because you have not yet defined the pipes and junctions in this model, all the
object ID numbers will change to red when you turn on Show Object Status.

Showing undefined objects
Another useful feature is the List Undefined Objects window (Figure 2.5). This
can be opened from the View menu by clicking on List Undefined Objects, or
by clicking the List Undefined Objects icon on the Workspace toolbar. All
objects with incomplete information are listed. Click on an undefined pipe or
junction to display the property data that is missing. Click the close button on
the bottom-right to stop showing this window.
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Figure 2.5 The List Undefined Objects window lets you see the
undefined properties for each object

A. Enter data for the J1 Tank
► To define the first tank, open the J1 Tank Properties window (Figure 2.6) by

double-clicking on the J1 junction.

Note: You can also open an object’s Properties window by selecting the object
(clicking on it) and then either pressing the Enter key or clicking the Open
Pipe/Junction Window icon on the Workspace Toolbar.

► Enter the following properties into the J1 Tank Properties window:
1. Name = Supply Tank

2. Elevation = 0 meters

3. Tank Model = Finite

4. Pressure = 45 bar

5. Temperature = 150 deg. C

6. Fixed Volume = 8.5 meters3

7. Initial Conditions = Known

8. Thermodynamic Process = Adiabatic
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Note: You can specify default units for many parameters (such as meters for
length) in the User Options window, accessed from the Tools menu under
Preferred Units.

You can give the junction a name, if desired, by entering it in the Name field at
the top of the window. By default, the junction's name is not specified. If a
junction name is entered, it will be displayed in the Model Data, Output, and in
Workspace Layers. In the steps above the name has been changed to Supply
Tank.

Most junction types can be entered into a custom Junction Library allowing the
junction to be used multiple times or shared between users. To select a junction
from the custom library, choose the desired junction from the Library List in the
junction's Properties window. The current junction will get the properties from
the library component.

The Copy Data From Jct... list will show all the junctions of the same type in the
model. This will copy desired parameters from an existing junction in the model
to the current junction.

Figure 2.6 Properties window for Tank J1
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Using the tabs in the Properties windows
The information in the Properties windows is grouped into several categories
and placed on separate tabs. Click the tab to bring its information forward.
Figure 2.6 is an example of a Tank’s Properties window.

The Tank Model tab is the tab that appears first when the Tank junction is
opened and contains all of the inputs required to define the Tank in steady-state.
While the Tank Model tab is specific to the Tank junction, the first tab opened
for any junction will contain all inputs required for that junction to be defined.

The Optional tab allows you to set Special Conditions (like closing a valve or
turning off a compressor), and change the junction icon.

Each junction has a tab for Notes, allowing you to enter text describing the
junction or documenting any assumptions.

The Status tab will state whether all required input data is present for a given
junction. If not, it will list all inputs that are incomplete.

► Click OK. If Show Object Status is turned on, you should see the J1 ID number
turn black again, telling you that J1 is now completely defined.

The Inspection feature
You can check the input parameters for J1 quickly, in read-only fashion, by
using the Inspection feature. Position the cursor on the Tank J1 junction and
hold down the right mouse button. An information box appears, as shown in
Figure 2.7.

Inspecting is a faster way of examining the input (and output if results are
available) than opening the Properties window.

Figure 2.7 Inspect junction properties from the Workspace by clicking
and holding the right mouse button

B. Enter data for the J2 Valve
The Valve is the element which will cause the transient in this model. The
purpose of the model will be to understand how the conditions within the supply
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tank and discharge pipe change after the valve opens.
► Double-click the J2 junction icon to open the Valve Properties window and

enter the following data on the Loss Model tab (Figure 2.8).
1. Elevation = 0 meters (by default, the elevation will be set to the value

specified in the last junction, and this behavior can be changed in the User
Options > Parameters > Pipes and Junctions section)

2. Loss Source = User Specified

3. Loss Model = Kv

4. Kv = 52

5. xT = 0.7

► Click the Optional tab and set the Special Condition to Closed. This will set
the initial steady-state Kv equal to 0. The Kv value defined above will represent
the final steady-state value after the transient valve movement has completed.

Figure 2.8 Input data for the J2 Valve

► Click the Transient tab and enter the following data (Figure 2.9).
1. Initiation of Transient = Time (indicates that the valve closure will be

initiated at the time you specify)
2. Enter the following Kv vs. Time data:

Time (seconds) Kv xT
0 0 0.7

0.1 52 0.7
240 52 0.7
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The first data point of the table must match the steady-state value of the
junction; therefore, the values are grayed out. In this case, the valve is closed in
the initial steady-state due to the Special Condition specified in the previous
step. Therefore, the initial transient data point automatically populates the valve
as being closed (Kv of zero means the valve is closed). The valve then fully
opens over a period of 0.1 seconds. It remains in this position for the rest of the
simulation.

Figure 2.9 Transient input data for the J2 Valve

► Click the OK button to save and close the Valve Properties window. There
should now be a “T” symbol next to the Valve junction on the Workspace,
indicating that transient data is entered for the junction. The Valve junction on
the Workspace will additionally have a red “X” next to it indicating that the
junction contains a Special Condition.

C. Enter data for the J3 Assigned Pressure
► Double-click the J3 junction icon to open the Assigned Pressure Properties

window and enter the following data (Figure 2.10).
1. Elevation = 0 meters

2. Boundary Specification = Stagnation

3. Stagnation Pressure = 1 bar

4. Temperature = 21.1 deg. C
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5. Click the OK button to save and close the Assigned Pressure Properties
window

Figure 2.10 Input data for the J3 Assigned Pressure

Save the model again before proceeding.

D. Enter data for Pipe P1
Data for pipes and junctions can be entered in any order. In this example, the
junctions were done first. The next step is to define all of the pipes.

► Open the Pipe Properties window for Pipe P1. The Pipe Model tab opens by
default (Figure 2.11).
1. Pipe Material = Steel - ANSI

2. Size = 2 inch

3. Type = STD (schedule 40)

4. Length = 6.1 meters

5. Friction Model = Standard
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Figure 2.11 Properties window for Pipe P1

The Pipe Properties window
The Inspect feature can be accessed not only from pipes and junctions located
on the Workspace, but also from within the Properties window of each pipe (and
certain junctions). This is helpful when you want to quickly check the properties
of objects that connect to a pipe or junction whose Properties window you
already have open.

To Inspect a junction connected to a given pipe, position the mouse pointer on
the connected junction’s ID number in that pipe’s Properties window (located at
the top right of the Pipe Properties window) and hold down the right mouse
button. This process can be repeated for any junction that states the upstream
and downstream pipe in the junction’s Properties window. You can jump to that
junction’s Properties window by double-clicking the connected junction’s ID
number, or use the Jump button to jump to any other part of the model.

► Click OK to save and close the Pipe Properties window for Pipe P1.

E. Enter data for Pipe P2
► Open the Pipe Properties window for Pipe P2 and enter the following data:

1. Pipe Material = Steel - ANSI

2. Size = 2 inch

3. Type = STD (schedule 40)

4. Length = 457 meters
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5. Friction Model = Standard

6. Click OK to save and close the Pipe P2 Properties window.

► Check if all the pipes and junctions are defined by clicking on the List
Undefined Objects button. If all data is entered, no items should appear in the
Undefined Objects window. If items are present, open the corresponding
Properties windows for the incomplete items from the Workspace. The Status
tab on each Properties window will indicate what information is missing.

F. Review model data
► Save the model. It is also a good idea to review the input using the Model Data

window.

Reviewing input in the Model Data window
The Model Data window is shown in Figure 2.12. To change to this window,
you can click on the Model Data tab, select it from the Window menu, or use
the CTRL+M keyboard shortcut. The Model Data window gives you a table-
based perspective of your model. Selections can be copied to the clipboard and
transferred into other Windows programs, saved to a formatted file, printed to a
PDF, or printed out for review. Figure 2.13 shows an expanded view of the
Transient Data tab from Figure 2.12. Here, all transient input data for the model
is shown.

Data is displayed in three general areas. The top is called the General data
section, the middle is the Pipe data section and the bottom is the Junction data
section. Each section is collapsible using the button at the top-left of the section.
Further, each section can be resized.

The Model Data window allows access to all Properties windows by double-
clicking on any input parameter column in the row of the pipe or junction you
want to access.
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Figure 2.12 The Model Data window displays all input in table form

Figure 2.13 The Transient data tab in the Model Data window displays
transient input data
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Step 4. Specify Analysis Setup

The Analysis Setup window allows the user to define fluid properties, view
undefined pipe/junction properties, section pipes, adjust simulation duration,
enable Add-on Modules if purchased and available on the current license, and
specify other simulation settings from a single central location.

► Click Analysis Setup on the Main Toolbar to open the Analysis Setup window
(see Figure 2.14). The Analysis Setup window contains various groups
depending on which modules you may be using. Each group has one or more
items. A fully defined group has every item within it defined with all required
inputs. Complete every group to run the Solver. A group or item that needs more
information will have a red exclamation mark to the left of the group or item
name. After completing a group, the group icon shows a green circle with a
checkmark. After defining all groups, thus completing the Analysis Setup, the
Model Status light in the lower-right corner of the Workspace turns from red to
green.

The Analysis Setup window can also be opened by clicking on the Model Status
Light on the Status Bar at the bottom-right corner of the xStream window
(Figure 2.3).

Figure 2.14 The Analysis Setup window tracks the defined and undefined
model inputs

A. Modules
Under the Modules group, click on the Modules item to open the Modules panel,
shown in Figure 2.14. Here you can enable and disable the Pulsation Frequency
Analysis (PFA) Add-on Module if it is available on the license. By default, the
model will have all modules disabled. Make no changes to this panel for this
example.
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B. Fluid Properties
► Select the Fluid item to open the Fluid panel (Figure 2.15).

This panel allows you to specify the fluid used in the model. There are several
fluid libraries that are available:
� xStream Standard - Common fluids from various industry standard sources

have been curve fit to optimize calculation speed.
� User Library Fluid - If the desired working fluid is not available via the

other sources, custom fluid properties can be entered and saved to the User
Library for repeated use in the future. Custom fluids are created by opening
the Library Manager from the Library menu or by clicking the Edit Fluid
List button in the Fluid panel and clicking Add New Fluid.

� ASME Steam Tables - Properties are calculated via the Equations of State
which were used to generate the classic steam/water tables in the IAPWS
Industrial Formulation (1997).

� Chempak - Optional add-on for purchase which contains data for several
hundred fluids and supports user-specified fluid mixtures. Chempak is
licensed from Madison Technical Software.

� NIST REFPROP - The Reference Fluid Thermodynamic and Transport
Properties (REFPROP) Database is licensed from the National Institute of
Standards and Technology (NIST) where properties for approximately 150
fluids are calculated via Equations of State. REFPROP supports user-
specified fluid mixtures.

► Select the xStream Standard fluid option, then choose Nitrogen (GN2) from
the list and click the Add to Model button. Leave the Equation of State as
Redlich-Kwong and the Enthalpy Model as Generalized.

Figure 2.15 Fluid panel of Analysis Setup
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C. Pipes and Junctions
The Pipes and Junctions panel is used to show the status of the pipes and
junctions on the Workspace. This item is incomplete if there are any undefined
pipes/junctions on the Workspace, or if there are no pipes/junctions on the
Workspace. In this example the objects in the Workspace are fully defined, so
this item is marked as complete.

Running models in steady-state
After fully specifying the Fluid panel and the pipes and junctions, sufficient
information exists to run the model in steady-state. You can run the model in
steady-state by selecting the Simulation Mode/Duration panel from the Transient
Control group and then choosing Arrow™ Steady for the Time Simulation. If
you do this, the other inputs on the Simulation Mode/Duration panel and the
Pipe Sectioning and Output panel will no longer be required, and the model can
be run.

In general, it is a good idea to always run your model in steady-state before
running the full transient analysis to make sure the model is giving reasonable
results. However, in this case the model has no flow in the steady-state due to
the closed valve, and a steady-state run is trivial. Keep the Transient option
selected.

D. Pipe Sectioning and Output
The next panel is the Pipe Sectioning and Output panel in the corresponding
group. The Pipe Sectioning and Output panel divides pipes into computation
sections in a manner which is consistent with the Method of Characteristics
(MOC).

To satisfy the MOC, the following equation must be valid:

where Δt is the time step, Δx is the section length, and c is the sonic velocity.

► Enter 1 for the Minimum Number of Sections Per Pipe.

The Minimum Number of Sections Per Pipe determines the section length by
taking the quotient of the shortest pipe's length and the Minimum Number of
Sections. Increasing the number of sections in a model will always have a
positive correlation to the model accuracy as the error inherent to the Method of
Characteristics decreases when the step size is made smaller. However, the run
time of the model increases quadratically as well, since each added section to the
shortest pipe increases the number of calculations for each time step. This
increase in run time is exacerbated when there is a large disparity between the
minimum pipe length and the length of the longest pipe, such as the case in this
model.

The Minimum Number of Sections Per Pipe for this example will be set to 1 for
expediency, but note that it would be wise to use more computational sections if
you are running an xStream model for real projects. Typically, less sections and
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faster run time is useful during the initial model development and
troubleshooting, and more sections can be used for final runs.

► Define the Estimated Maximum Pipe Temperature During Transient as 930
deg. C.

The Estimated Maximum Pipe Temperature During Transient is used to
calculate the maximum sonic velocity. Since all pipes in the network must be
solved together, the time step must be the same for each pipe. However, the
sonic velocity will not be equivalent for all of the pipes. Therefore, the sonic
velocity at the specified maximum temperature is used to find a uniform time
step for the system. Without a uniform time step, the MOC could fail. Choosing
a maximum temperature that is much higher or much lower than the maximum
temperature calculated during the run can result in additional uncertainty in the
MOC solution. It is generally recommended to choose a conservatively high
temperature for the model initially. The results of the initial run can then be used
to refine the Estimated Maximum Temperature During Transient for subsequent
runs.

The Estimated Maximum Pipe Mach Number During Transient is an additional
parameter that affects result accuracy. The value of this parameter is set to 1 by
default so that the Method of Characteristics grid is able to bound the sonic
velocity obtained at the Estimated Maximum Pipe Temperature During
Transient. Setting the Mach number to 1 ensures that the model will not fail
assuming the input values for that variable are correct.

However, because of the computational methodology of the MOC, using the
default Mach number can introduce error due to the difference between the
Estimated Maximum Pipe Mach Number During Transient and the actual
maximum. This error is particularly noticeable when the Mach number during
the simulation is near zero. If the maximum Mach number reached during the
simulation is near zero, a more accurate model can be found by lowering the
estimated maximum based on the actual Maximum Mach number of the system.

To change the Estimated Maximum Pipe Mach Number During Transient, you
must expand the Advanced Sectioning Controls dropdown in the Pipe Sectioning
and Output panel of Analysis Setup. It is highly recommended that you first run
the model with the default Mach number in order to ensure that choking does
not occur in the pipes before altering this number. Additionally, be cognizant of
the fact that altering sectioning, transient components, or maximum estimated
temperatures between runs could have an effect on the maximum Mach number
reached during the simulation. As such, it is generally recommended to only
change this number once your model has reached a more finalized state.

Sonic choking will be seen in this model, so no adjustment to Maximum Mach
Number will be made.

The Sectioning Summary underneath the inputs will be partially filled in.
Certain properties such as the Estimated Total Steps and Total Pipe
Computations will need the Simulation Mode/Duration panel to be completed
before values can be displayed.
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Figure 2.16 The Sectioning panel in the Analysis Setup window is used to
calculate the time step of the model

E. Transient Control
► Select the Simulation Mode/Duration panel. Enter 0 seconds for the Start

Time and 240 seconds for the Stop Time (Figure 2.17).
► Click OK to accept the changes in Analysis Setup.

Figure 2.17 The Simulation Mode/Duration panel is used to specify the
simulation type and the time span for the transient

► Save the model.
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Step 5. Run the model
► Choose Run Model... from the Analysis menu or click the Run Model button

on the Common Toolbar. During execution, the Solution Progress window is
displayed and can be used to pause or cancel the Solver's activity (Figure 2.18).
Note that the Time Step is also shown on the Solution Progress bar to help
identify the point of failure in the event of a failed convergence.

This simple model will take several minutes to run. A typical xStream model
may take hours to solve depending on the simulation duration, sectioning, and
which fluid library is used.

Figure 2.18 The Solution Progress window displays the state of the
simulation

The two Solvers
xStream has two Solvers. The first is called the Arrow™ Steady Solver, which
as its name suggests, obtains a steady-state solution to the pipe network. The
second Solver is called the Transient Solver and solves the gas transient
equations via the Method of Characteristics (MOC).

The Arrow™ Steady Solver and Transient Solver use different sectioning
methods which causes small discrepancies between the converged Arrow™
Steady solution and the first time step of the transient solution. xStream runs the
Transient Solver for a period of time before the transient simulation begins in
order to allow these artificial waves caused by these discrepancies to dampen
and die out. Once the artificial transients have settled, xStream checks the
solution with resolved artificial transients against the Arrow™ Steady solution.
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If the mismatch between the beginning and end of the artificial transient
resolution process is sufficiently small xStream proceeds with the transient
simulation. See the chart in Figure 2.19 as a visual representation of the process
described above.

Figure 2.19 Illustration of the Transient Solver Initialization process with
artificial transient resolution

► When the solution is obtained, click the Output button to display the table-
based Output window. The information in the Output window can be reviewed
visually on the screen, saved to a file, exported to a spreadsheet-ready format,
copied to the clipboard, or printed.

The output file
When the Solver runs, the output data is written to a file. This file is given the
same name as the model itself with a number appended to the name, and with an
*.out extension appended to the end. For all data processing, graphing, etc., the
data is extracted from this file. The number is appended because users are able
to build different scenarios all within this model. Each scenario will have its
own output file; thus, the files need to be distinguishable from each other.

The output file will only remain on disk if you save the model after it has
been run. Once saved, it will remain until the user erases it or the model input
data is modified.

► Save the model file again such that the output file is saved to the disk. This
means that if you were to close your model right now and then reopen it, you
could proceed directly to the Output window for data review without rerunning
your model.

Step 6. Review the Output window

The Output window (Figure 2.20) is similar in structure to the Model Data
window. Three areas are shown, and you can minimize or enlarge each section
by clicking the arrow next to the General, Pipes, and All Junctions tabs. The
items displayed in the tabs can be customized with the Output Control window,
which can be opened by clicking the spreadsheet with a pencil icon from the
Common Toolbar or from the Tools dropdown menu.

The General section will open by default to the Warnings tab if any Warnings or
Cautions were encountered during the simulation. This model should generate a
Caution that the Maximum Transient Pipe Mach Number is at least 0.2 higher
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than the steady pipe Mach number, which occurs since there is no flow in the
system at steady-state. When this Caution is present, the effect of pipe
sectioning on results can be significant. The impact of pipe sectioning will be
addressed in greater detail in a later step.

The Output window allows you to review both the steady-state and transient
results. The Pipes tab, All Junctions tab, and any specific junction tabs in the
Junction section (such as Tank, Valve, etc.) show the steady-state results. A
summary of the maximum and minimum transient results for each pipe is given
on the Transient Max/Min tab in the Pipe section and is the active tab displayed
in Figure 2.20. You can review the solutions for each time step (i.e., a time
history) on the Transient Output tab shown in Figure 2.21. Note that in order to
display all pipe stations the model will need to be set to save data for all
stations. By default, xStream saves all data points. This can be changed in the
Pipe Sectioning and Output panel.

Figure 2.20 The Output window displays steady-state and transient
output in tabular form

Figure 2.21 The Output window displays transient data from each time
step
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Figure 2.22 The Output window displays the values of steady-state
parameters in the Pipes tab

► Click on the Event Messages By Time tab. This tab allows you to review
changes of states at junctions, such as the onset of choking or the initiation of
transient events (see Figure 2.23). There should be messages indicating that the
J2 Valve experienced a near instantaneous choking that dissipated after about
0.06 seconds while the J3 Assigned Pressure experienced choking after 2.3
seconds that lasted until approximately 128.9 seconds. Choking is an important
phenomenon to pay attention to as it indicates that the fluid has reached sonic
velocity. This has significant implications for the MOC calculation method as
will be discussed later.

Figure 2.23 Event Messages by Time tab displays important system
behavior

The Output Control window (Figure 2.24) can be accessed from either the Tools
menu or from the Output window Toolbar, and it allows you to select the
specific output parameters you want to display in the Output window. You can
choose the units and reorder the parameters as desired. If you do not change any
of the Output Control settings, the default Output Control parameters are
assigned.
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Figure 2.24 The Output Control window lets you customize the output

Units for each column in the Output window can also be changed by double-
clicking the column header. This will open a window in which you can select
the units you prefer (Figure 2.25). These changes are extended to the Output
Control parameter data that is set.

Figure 2.25 The Change Units window is opened from the Output window
tabs by double-clicking a column header

Step 7. View the Graph Results

For transient analysis, the Graph Results window will usually be more helpful
than the Output window because of the more voluminous data.

► Open the Graph Results window by clicking the Graph Results tab, choosing
it from the Windows menu, or by pressing CTRL+G.
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xStream's Graph Guide feature, accessed by clicking on the "What Would You
Like to Do?" button located at the top-right of the Graph Results window,
provides assistance by guiding you through the creation of a Quick and Simple
graph, or an Advanced graph (Figure 2.26). You can create a graph by following
the prompts on the Graph Guide, or by manually specifying the graphing
parameters on the Graph Control tab on the Quick Access Panel, or from the
Select Graph Parameters icon located in the top-left corner of the Graph Results
Toolbar. For the remainder of this Quick Start Guide, the Graph Guide will be
hidden, but keep in mind you can use it whenever you would like assistance in
creating a graph.

Figure 2.26 The Graph Guide

Figure 2.27 shows the Graph Results window with the Graph Control tab
selected on the Quick Access Panel.

Figure 2.27 The Graph Results window and Quick Access Panel Graph
Control tab is where various system parameters (both steady-
state and transient) can be graphed

A. Create a Transient Pipe graph
xStream gives you the ability to create stacked graphs. These are graphs that are
vertically aligned such that they use the same same x-axis but have different
parameters on the y-axis of each graph. This feature is helpful when you want to
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look at how different parameters vary with time at a given position without
having to create separate graphs.

► Access the graphing parameters by opening the Graph Control tab on the
Quick Access Panel (this tab is automatically selected when the Graph
Results window is opened). Because we are interested in seeing how the
pressures and flows in specific pipe sections respond over time, ensure that the
Transient Pipe tab is selected in the Parameters/Formatting area on the Quick
Access Panel. Alternatively, you can open the Select Graph Parameters window
by clicking on the corresponding icon on the Graph Results Toolbar (Figure
2.27).

► Add the Pipe P2 Outlet to the Graph These Pipes/Stations list by expanding
the tree for Pipe P2 under the Select Pipe Stations list and double-clicking the
Outlet station. Pipe P2 Outlet represents the pipe computing station at the
discharge of the blowdown pipe. Alternatively, you can click on the right arrow
button after selecting the pipe station you want to graph to add it to the Graph
These Pipes/Stations list.

► Verify the Time Units are set to seconds and the Time Frame is set to All
Times.

► Click the Add button twice, which is the green “+” icon next to Select
Parameter. Two new rows will appear under the Parameter definition area which
will create stacked graphs (Figure 2.28).

► Select the following parameters from the dropdown lists on each row:
1. Temperature Static with units of deg. C

2. Velocity with units of meters/s

3. Mach Number

Figure 2.28 shows the input in the Parameters/Formatting area on the Quick
Access Panel.
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Figure 2.28 The Graph Control tab on the Quick Access Panel allows you
to specify the graph parameters you want to graph in the
Parameters/Formatting area

► Click the Generate button at the bottom of the Quick Access Panel to create
the static temperature, velocity, and Mach number graphs at the pipe discharge
over the duration of the simulation.

► Format the legend font size to 20 pt by right-clicking on any legend and using
the scroll bar. Drag the legend to the top-right corner of the graph.

► Format the y-axis and x-axis font size to 20 pt by right-clicking on each axis
parameter and using the scroll bar.

Figure 2.29 shows the stacked graphs detailing the static temperature, velocity,
and the Mach number at Pipe P2 outlet over the course of 240 seconds. Here
you can see that the maximum temperature at the discharge is about 800 deg. C.
Also note that the maximum temperature in Figure 2.29 does not approach the
value indicated in the Transient Max/Min tab. This is because the Transient Pipe
graph shows only the outlet station (station 75), while the maximum temperature
in Pipe P2 is reached at station 66.

Note: The axis titles in the stacked graphs in Figure 2.29 have been modified for
clarity.

The Formatting area on the Graph Control tab can be used to modify the graph
colors, fonts, and other elements. Options to copy the graph image or x-y data
are available on the Graph Results Toolbar or by right-clicking the graph. The
graph image or x-y data can be saved from the File menu.
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Figure 2.29 Static temperature, velocity, and Mach number of Pipe P2
outlet

Further review of the graph results in Figure 2.29 shows that sonic choking
occurs after several seconds, as was seen on the Event Messages tab in the
Output window, and continues for the next 130 seconds. Also note that the
temperature, velocity, and Mach number all rise sharply shortly after the valve
opens, with the Mach number rapidly reaching one. After the initial rise, the
temperature and velocity both decay while the Mach number remains at one.
The velocity drops because sonic velocity has a positive correlation with
temperature, so as the temperature decays, the velocity required for choked flow
also decreases. This relationship is important to understand when looking at
systems that encounter choking.

B. Create a Transient Junction graph
For the purpose of this analysis, it is also helpful to look at the temperature and
pressure of the tank over time.

► Create a new graph tab by clicking the New Tab button which is the green
plus icon located on the bottom-right, immediately below the graph area (Figure
2.27).

► Click the Transient Jct tab on the Graph Control tab of the Quick Access
Panel (Figure 2.30). Add the J1 (Supply Tank) junction.
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► Verify the Time Units are set to seconds and the Time Frame is set to All
Times.

► Click the Add button to add a new row under the Parameter definition area.

► Select the following parameters from the dropdown lists on each row:
1. Pressure Stagnation with units of bar

2. Temperature Stagnation with units of deg. C

► Click the Generate button. These graphs show the tank pressure and
temperature initially decrease quickly, then decrease more slowly as time
progresses. This change in slope is due to a decreasing pressure gradient
between the tank and the atmosphere as the tank is emptied, which slows the
mass flow rate out of the tank (Figure 2.31).

Note: xStream assumes all pipes are adiabatic (perfectly insulated). Over a 240
second run time this assumption may not be accurate. Consider this when
evaluating simulation results over longer times.

Figure 2.30 Graph Parameters window for the Transient Junction graph
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Figure 2.31 The Transient Junction graph shows how variables within a
junction change over time, such as with the temperature and
pressure of Tank J1

This junction graph could be used to determine when certain conditions within
the tank were met. For instance, suppose there was a need to know when the
tank pressure dropped below 25 bar. The junction graph would indicate the tank
pressure would reach such a point around 60 seconds after beginning the tank
blowdown.

C. Create an Animated Profile graph
Lastly, we will animate the profile of the system to show the wave caused by
opening the valve.

► Create a new graph tab and select the Profile tab. Under Plot Single Path,
select Pipe P1 and P2. After ensuring your Length Units are meters, select the
option to Animate Using Output and ensure the Animation Time Units are set to
seconds.

Add new parameters until you have 4 in total, and set them to the following
(see Figure 2.32):
1. Pressure Static with units of bar

2. Temperature Static with units of deg. C

3. Velocity with units of meters/sec

4. Density Static with units of kg/m3

► Click the Generate button. This will show the max and min envelopes of the
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parameters throughout the selected time frame. The animation can started by
clicking Play in the top-left playback controls (Figure 2.33).

Figure 2.32 Profile Graph Parameters window
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Figure 2.33 The Profile Graph show the Maximum and Minimum values of
all parameters shown in the Graph over the specified time
Frame, and can also animate the values

Take note of the pressure wave that is created at the valve just after animation is
started. This wave travels to the Assigned Pressure junction before reflecting
back towards the valve. The amount of time it takes this wave to travel to the
reflection point and back is called the communication time. It should be noted
when creating your transient that any event which occurs over a shorter length
of time than the communication time of the system is considered to happen
instantaneously.

Step 8. View the Workspace Layers

Workspace Layers can display input and output data values superimposed over
the graphical model layout. They can also overlay additional graphical
modifications, animations, and customize the appearance of objects in the
model. The displayed data can be organized on one or more layers which can be
toggled on or off, allowing flexibility for viewing results in a graphical manner.

► Navigate to the Workspace window by clicking on the Workspace tab or
pressing CTRL+W. Select the Workspace Layers tab in the bottom-right of the
Quick Access Panel. The Workspace Layers panel contains two sections named
Layer Presets and Layers.

40 xStream 4 Quick Start Guide



Within the Layers section, there are two layer groups named Advanced Layers
and Standard. We will integrate the model results with the graphical layout of
the pipe network by using a Standard layer. All models must have at least one
Standard layer, so by default there will be a "Layer 1" automatically created. It
will contain all objects in the model (pipes, junctions, annotations, etc);
however, objects can be hidden if desired, or the visibility of the entire layer
itself can be toggled on/off using the eye icon next to the layer. When additional
layers are created they will stack on top of each other, with the layers on top
taking precedence over others below. The combination of layers and toggling
visibility allows for a wide range of visual customization.

► Open the Layer Settings window for Layer 1 by double-clicking the layer.
The Layer Settings window is shown in Figure 2.34.

The Layer Settings window provides flexible options for customizing the
appearance of the model. The Pipes & Junctions group allows you to show or
hide junctions, and change display properties like color, size, and thickness. The
Label Control group allows you to display input and output parameters next to
objects on the Workspace. The Annotations group allows you to customize
annotations.

Figure 2.34 The Layer Settings window specifies content to be
superimposed on the Workspace

► Select the Pipe Parameters item under the Label Control group. The left
pane lists input and output parameters available for display, and the right pane
lists the parameters currently being displayed by the layer on the Workspace.

► In the left pane, expand the Pipe Max/Min Parameters list. Then, select Max
Temperature Static in the list with units of deg. C. Add it to the right pane by
either double-clicking the parameter, or selecting the parameter and clicking the
arrow between the panes. Repeat the process to add the Min Temperature Static
parameter with the same units.
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► Add additional clarity by repositioning the labels and adding a legend. It is
common for the text on the Workspace Layers to overlap with objects when first
generated. Labels can be dragged to a new area or a smaller font can be selected
using the Font Decrease icon on the Workspace Toolbar or from within the
Global Layer Settings. Parameter units can be consolidated in a legend which
can be added via the Global Layer Settings. In the Layers Toolbar, click the
double gear icon to open the Global Layer Settings. Then, enable the checkbox
for Show Units in Legend. The result of these adjustments is shown in Figure
2.35.

Figure 2.35 Results are superimposed on the model layout via Workspace
Layers

Step 9. Examine the effect of sectioning

In xStream, sectioning plays an important role in model accuracy. Due to how
the MOC operates, accuracy increases with the number of sections you have in
the model. To illustrate this, the model was re-run with a Minimum Number of
Sections Per Pipe of 6 instead of 1. Comparing Figure 2.31 to Figure 2.38,
values such as the temperature and pressure for Tank J1 remain similar with the
increase in the number of sections. However, values such as the maximum
temperature reached in Pipe P2 (Figure 2.20 and Figure 2.36), changed
substantially. This value increased from 919 deg. C to 1203 deg. C. This change
in the maximum temperature indicates that the difference in sectioning has
significant implications if your interest is in the conditions in the blowdown
pipe. It should be noted that changing the Minimum Number of Sections Per
Pipe from 1 to 6 caused the computation time of the model to increase from a
couple minutes to a couple hours. Therefore, it is of critical importance to
balance accuracy and computation time when using xStream.

Due to the long run time, it was not sensible to ask you to run the 6 section
scenario as a part of this example. If you are interested, you may want to run
this scenario overnight.
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Figure 2.36 Transient Min/Max tab of the Output for a modified sectioning
scenario

Figure 2.37 Temperature, velocity, and Mach number for the discharge of
Pipe P2 with 6 sections minimum per pipe
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Figure 2.38 Temperature and pressure stagnation for Tank J1 with 6
sections minimum per pipe

Conclusion

You have now used the Primary Windows in xStream to build and analyze a
simple gas transient model. Pipes and junctions were placed on the Workspace
and defined by entering data into their Properties windows. Analysis Setup was
used to select a fluid, section the pipes, and enter a duration for the transient
simulation. The model was run and results were viewed in the Output window.
Different types of graphs were created to analyze the system behavior, and the
effect of sectioning was discussed.
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C H A P T E R 3

Gas Turbine Fuel System Example

Problem Statement

The combustion baskets in a natural gas fuel system are fed by a positive
displacement compressor. The natural gas is preheated by a heat exchanger
before passing through the three control valves, with each feeding a separate
combustion basket. One of the control valves experiences a nearly instantaneous
closure. The objective is to determine the maximum fluid temperature reached
during the transient, both in the entire system, and at the inlets of the
combustion baskets. The effect of this transient event on the temperature,
pressure, and velocity of the system should be observed.

As the design engineer, you are also responsible for evaluating the sensitivity of
the results to the Minimum Number of Sections Per Pipe parameter.

Topics Covered
� Using the Global Edit Tool

� Modeling a valve closure as a transient event

� Modeling a heat exchanger

� Using the Scenario Manager

� Importance of the Estimated Maximum Temperature During Transient
setting

� Finding the max and min values for transient parameters

� Creating animated profile graphs

Required Knowledge

This example assumes that the user has some familiarity with xStream such as
placing junctions, connecting pipes, and entering pipe and junction properties.
Refer to the example in Chapter 2 for more information on these topics.
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Model File

A completed version of the model file can be referenced from the Examples
folder as part of the xStream installation:

C:\Users\[username]\Documents\Datacor\xStream 4\Examples
� Metric - Gas Turbine Fuel System.xtr

Step 1. Build the model

A. Place the pipes and junctions
► In the Workspace window, assemble the model as shown in Figure 3.1.

Figure 3.1 Layout of the system on the Workspace

B. Enter the pipe and junction data
The system is in place but now the input data for the pipes and junctions needs
to be entered. Enter the following data in each Pipe and Junction Properties
window.

All Pipes are Stainless Steel - ANSI, Schedule 10S, and have standard
roughness. The rest of the pipe information is as follows:
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Pipe # Size (inches) Length (meters)
1 8 23
2 8 7.5
3 8 1.5
4 5 1.5
5 5 1.5
6 8 1.5
7 5 1.5
8 5 1.5
9 8 1.5
10 5 1.5
11 5 1.5

Because several of the pipes are the same, you can use the Global Pipe Edit tool
to speed up the process of entering the data. The Global Pipe Edit tool allows
you to apply changes to multiple pipes at the same time.

► Select Global Pipe Edit either from the Edit menu, or by selecting the Global
Edit dropdown on the toolbar (blue globe symbol) and selecting the Global Pipe
Edit option. This will open the Global Pipe Edit window.

► Select Pipes P4, P5, P7, P8, P10, and P11 from the list of pipes as shown in
Figure 3.2.

Figure 3.2 Global Pipe Edit window

► Click the Select Pipe Data button. This will open a template Pipe Properties
window for entering the data to be applied to all of the selected pipes.

47 xStream 4 Quick Start Guide



► Fill out the data for the selected pipes. When you have entered all of the data
for the pipes, close the Pipe Properties window by selecting OK. The Global
Pipe Edit window will now display a list of all of the parameters that may be
applied to the selected pipes. The parameters are categorized as they are
displayed on the tabs in the Pipe Properties window.

► Select the All button above the Parameters to Change list, since for this
example, you want all of the parameters for all of the selected pipes to be
updated to the specified values. The Global Pipe Edit window should now
appear as shown in Figure 3.3.

Figure 3.3 Global Pipe Edit window with all pipe parameters selected for
updating

► Apply the changes to the selected pipes by clicking the Apply Selections
button. xStream will notify you that the changes have been completed with a
message in the bottom-left of the Global Pipe Edit window. At this point, all of
the changes have been applied but not saved. If you wish to cancel all of the
changes you just implemented, you may do so by clicking Cancel on the Global
Pipe Edit window.

► Save the applied changes by clicking OK.

Note: The Guide button in the Global Edit windows may be used as a reminder
of the required steps for the global edit process if needed.
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J1 - Assigned Flow
1. Name = PD Compressor

2. Elevation = 0 meters

3. Mass Flow Rate = 41400 kg/hr

Note: Be advised that the unit for mass flow is not the default, it is kg/hr
as opposed to kg/s.

4. Temperature = 21 deg. C

J2 - Heat Exchanger
In the Loss Model tab enter the following:
1. Name = Natural Gas Heater

2. Elevation = 0 meters

3. K = 6.6

In the Thermal Data tab enter the following:

Steady Heat Rate = 1035 kW

J3 - Valve
1. Elevation = 0 meters

2. Loss Source = User Specified

3. Kv = 8650

4. xT = 0.3

J4 and J7 - Tee
Elevation = 0 meters

J5 - Valve
1. Name = Diffusion Gas FCV

2. Elevation = 0 meters

3. Loss Source = User Specified

4. Kv = 80

5. xT = 0.7

J6, J9, and J12 - Assigned Pressure
Because all of the Assigned Pressures have similar input data, the Global
Junction Edit tool could be used to input the data for all of the junctions at the
same time. The Global Junction Edit tool works in much the same way as the
Global Pipe Edit tool.

Another tool that can be used to speed up data entry for items with the same
input data is the Copy Data From Junction tool.
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► Enter the data for Assigned Pressure J6, as listed below:

1. J6 Name = Combustion Basket #1

2. Elevation = 0 meters

3. Stagnation Pressure = 15.7 bar

4. Temperature = 60 deg. C

5. Click OK to close the Assigned Pressure Properties window

► Open the junction J9 Properties window. Near the top of the Properties
window is a drop-down box labeled Copy Data From Jct. This box lists all of
the Assigned Pressure junctions on the Workspace. Select junction J6 from the
list. This will open the Copy Data From Junction window, which shows a list of
all of the parameters for junction J6, and their values. By checking the box
beside a parameter, the current junction will copy the parameter value from J6.
In this case, you want all of the parameters for J9 to be the same as J6 except for
the name.

► Select the All button at the top of the list.

► Un-check the Name parameter, as shown in Figure 3.4.

Figure 3.4 The Copy Data From Junction window
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After clicking the OK button in the Copy Data From Junction window, the
selected junction J9 parameters are updated to the selected J6 parameter values.

► Set the name of junction J9 to Combustion Basket #2 and click OK.

► Repeat the Copy Data From Junction process for J12, and give it the name
Combustion Basket #3.

J8 - Valve
1. Name = Premix Gas FCV #1

2. Elevation = 0 meters

3. Loss Source = User Specified

4. Kv = 170

5. xT = 0.7

J10 - Branch
Elevation = 0 meters

J11 - Valve
1. Name = Premix Gas FCV #2

2. Elevation = 0 meters

3. Loss Source = User Specified

4. Kv = 170

5. xT = 0.7

6. On the Transient tab, enter the following data:

Time (seconds) Kv xT
0 170 0.7

0.01 0 0.7
2 0 0.7

C. Check if the pipe and junction data is complete
► Open the List Undefined Objects window from the View menu or the

Workspace Toolbar to verify if all pipes and junctions are specified. If not, the
incomplete pipes or junctions will be listed. If undefined objects are present, go
back to the incomplete pipes or junctions and enter the missing data.

Step 2. Specify Analysis Setup

A. Specify the Fluid panel
► Open the Analysis Setup window by clicking Analysis Setup on the Common

Toolbar.
► Select Methane from the xStream Standard fluid library, and click the Add

to Model button.
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Note: Methane is used to approximate natural gas in order to minimize the run
time. This is typically a fair assumption for preliminary runs. If you need to
model a real natural gas mixture, such as for a final run, then the NIST
REFPROP library or the optional Chempak add-on can be used. Be aware that
mixtures with multiple components may drastically increase the runtime.
Limiting the mixture to 3 or 4 components is advised.

B. Specify the Pipe Sectioning and Output panel
► Open the Pipe Sectioning and Output panel and specify the following:

1. Minimum Number of Sections Per Pipe = 8

2. Estimated Maximum Pipe Temperature During Transient = 60 deg. C

Note: If following along in the completed model file, the Estimated Maximum
Pipe Temperature During Transient will have a different value. This will be
discussed in later steps.

C. Specify the Simulation Mode/Duration panel
► Enter a Stop Time of 2 seconds on the Simulation Mode/Duration panel

from the Transient Control group. Verify the Time Simulation is set to
Transient. Click the OK button.

Step 3. Create scenarios to model different sectioning setups

A. Create scenarios
In this model, the following types of Sectioning cases for the system are to be
evaluated:
1. 8 Sections Minimum per Pipe

2. 4 Sections Minimum per Pipe

3. 2 Sections Minimum per Pipe

We will utilize the Scenario Manager to set up these cases.

The Scenario Manager is a powerful tool for managing variations of a model,
referred to as scenarios. The Scenario Manager allows you to:
� Create, name, and organize scenarios

� Select the scenario to appear in the Workspace (the current scenario)

� Delete, copy, and rename scenarios

� Duplicate scenarios and save them as separate models

� Review differences between scenarios using the Scenario Comparison Tool

� Propagate changes from a parent scenario to its children

You will create three scenarios to model these cases. Scenarios are created using
the Scenario Manager from the Tools menu or the Scenario Manager on the
Quick Access Panel. The Quick Access Panel, located on the right side of the
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Workspace area, contains the Scenario Manager on the Scenario tab. A scenario
tree displays all model scenarios.

► Click the Create Child button on the Scenario Manager on the Quick Access
Panel. Name the child "8 Sections Minimum Per Pipe". A new scenario will
appear below the Base Scenario in the scenario tree. Select the Base Scenario,
create another child, and call it "4 Sections Minimum Per Pipe". Finally, select
the Base Scenario again and create a third child called "2 Sections Minimum Per
Pipe" (see Figure 3.5). Note that the new child scenario is loaded when it is
created using the Scenario Manager on the Quick Access Panel.

Figure 3.5 Create model variants and keep them organized using the
Scenario Manager on the Quick Access Panel

B. Set up scenarios
Child scenarios inherit data from their ancestor scenarios. As long as the data
has not been modified in a child scenario, data parameters in the child scenario
will have the same value as their parent. Scenarios can be loaded onto the
Workspace by double-clicking their name in the Scenario Manager. The
currently loaded scenario is indicated in the scenario tree with a green circle
with a checkmark (Figure 3.5). Since the Base Scenario already has been set up
with 8 Minimum Sections Per Pipe, the 8 Sections Minimum Per Pipe child does
not need to be modified.

► Load the 4 Sections Minimum Per Pipe scenario by double-clicking the name
in the Scenario Manager. Open the Analysis Setup window from the Common
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Toolbar. Open the Pipe Sectioning and Output panel and then click OK.
► Change the Minimum Number of Sections Per Pipe to 4 from the Pipe

Sectioning and Output panel in Analysis Setup, then click OK. The required
input for this scenario is now complete.

► Repeat the steps above for the 2 Sections Minimum Per Pipe scenario, and
change the value to 2.

Step 4. Run the first scenario
► Double-click the 8 Sections Minimum Per Pipe scenario in the Scenario

Manager.
► Click the Run Model button on the Common Toolbar or select the option

from the Analysis menu. xStream will prompt you to save the model if you have
not done so already, then will open the Solution Progress window.

Step 5. Review the results
► Click the Output button. This will take you to the Output window, which will

display any warnings if they exist. There should be a warning indicating that the
maximum transient pipe temperature was higher than the estimate as well as a
caution that the maximum transient pipe mach number was significantly lower
than the estimate (see Figure 3.6). The Estimated Maximum Pipe Temperature
During Transient is critical to the calculation of transient conditions due to its
necessity in the Method of Characteristics.

The Estimated Maximum Pipe Temperature During Transient is used to
calculate the sonic velocity of the fluid, which is then used to create the upper
boundary of the characteristic grid. If the maximum temperature during the
transient exceeds the specified Estimated Maximum Pipe Temperature During
Transient and the flow is sonic, the Method of Characteristics may have to
extrapolate data, which can lead to instability and will stop the transient solver.
In this model, sonic velocity was not reached when the temperature was higher
than the estimated maximum. However, to ensure that this model can handle
sonic flow, we will re-run the model with a higher Estimated Maximum Pipe
Temperature During Transient.

The Maximum Transient Pipe Mach Number warning indicates that error could
be introduced through having a Mach Number substantially lower than the
Maximum Transient Pipe Mach Number used for the calculation (in this case,
the xStream default value of 1). This caution will be ignored in this example for
simplicity.
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Figure 3.6 The maximum transient pipe temperature exceeds estimated
maximum temperature warning indicates that the model is at
risk of instability if changes are made

Step 6. Adjust the Pipe Sectioning panel
► Double-click the Base Scenario in the Scenario Manager. Open the Analysis

Setup window from the Common Toolbar and select Change the Click OK.
► Change the Estimated Maximum Pipe Temperature During Transientto 80

deg. C from the Pipe Sectioning and Output panel.

Important: Making this change in the Base Scenario will save time since it will
propagate the change to all scenarios automatically.

Step 7. Re-run the model and review results

A. Review Output window
► Re-run the 8 Sections Minimum Per Pipe scenario, then proceed to the

Output window. There should be a caution indicating that the maximum
transient pipe mach number was significantly lower than the estimate. Disregard
this caution as discussed previously.

Select the Transient Max/Min tab as shown in Figure 3.7. Here we can see the
maximum static temperatures in the pipes (scroll to the right in the Pipes section
of the Output). Note that the values here are accounting for the entire length of
the pipe, and the corresponding Station at which the max/min values occurred is
reported.

The max static temperature for the entire system occurs at the inlet of Pipe
P2 (Station 0), with a value of about 77.6 deg. C. This is intuitive because the
Pipe P2 inlet is equivalent to the J2 Heat Exchanger outlet, which adds heat to
the system. Furthermore, if we observe the pipes that feed the combustion
baskets (Pipes P5, P8, and P11) we can see that max static temperatures occur at
the inlets (Station 0). Therefore, to find the max temperatures for the pipe
outlets, which correspond to the combustion basket inlets, we will need to create
transient graphs.
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Figure 3.7 Transient Max/Min tab in the Output window

B. Graph the results
Go to the Graph Results window by clicking on the Graph Results tab or
pressing CTRL+G on the keyboard.

► Create a graph that shows the temperature over time at the entrance to
Combustion Basket #1 using the following steps (Figure 3.8):
1. From the Graph Control tab on the Quick Access Panel, select the

Transient Pipe tab
2. Select Pipe P5 and add the outlet station

3. Verify that the time units are set to seconds

4. In the Parameters definition area, select Temperature Static with units of
deg. C

5. Click the Generate button

56 xStream 4 Quick Start Guide



Figure 3.8 Graph Parameters for Combustion Basket #1 Inlet

► Right-click on the resulting graph and select Show Cross Hair, or enable it
via the icon on the Graph Toolbar. Moving your mouse cursor over the graph
will display the numerical values of the graph data points. This can be used to
find the max value, or you can right-click on the graph and select Copy X-Y
Data, which can be pasted into Excel or other software utilities for further
inspection.

The max temperature at the inlet of Combustion Basket #1 is about 72.3 deg. C.
Note that this temperature is lower than the temperature shown on the Transient
Max/Min tab because this graph is showing the outlet of Pipe P5, while the
maximum temperature in Pipe P5 occurs at the inlet of the pipe. The maximum
temperature for the outlet of Pipe P5 occurs at about 0.55 seconds before
trending back towards the previous steady-state temperature of 60 deg. C as the
flow normalizes.

Note: The Assigned Pressure junctions in this model were defined with
Stagnation Temperature. Therefore, the Static Temperature will be lower than
the Stagnation value, as is seen in Figure 3.9. In the case of Pipe P11 where the
flow is zero after the valve closure, the Static and Stagnation Temperatures will
be equal.
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Figure 3.9 Temperature Static vs Time for the inlet to Combustion
Basket #1

To easily recreate this graph in the other scenarios or in the future, it can be
added into the Graph List Manager on the Quick Access Panel.

► Right-click the graph and select Add Graph to List from the context menu, or
use the icon from the Graph Results Toolbar. Give the graph a name, such as
“Combustion Basket #1 Temperature vs Time”, then click OK. The graph will
be added to the currently selected folder in the Graph List Manager. Note that
graphs added to the Graph List Manager are not permanently saved until the
model is saved again. Also be aware that only the graph settings are saved as
opposed to the graph data.

► Create the same graph above for Combustion Basket #2 and #3, and save
them as Graph List Items. Combustion Basket #2 corresponds to the Pipe P8
Outlet station, and Combustion Basket #3 corresponds to the Pipe P11 Outlet
station. Combustion Basket #2 will have a similar graph with a slightly lower
maximum. Combustion Basket #3 will have a flat graph due to the valve
closure, and the temperature settles out to the boundary condition of the J12
Assigned Pressure since Pipe P11 is adiabatic with no heat transfer.

Table 3.1 Summary of the Combustion Basket max static temperatures for the
8 Sections scenario

Combustion Basket Max Transient Temperature (deg. C)
#1 (Pipe P5 Outlet) 72.3
#2 (Pipe P8 Outlet) 71.9

#3 (Pipe P11 Outlet) 60.0
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C. Animate the results
xStream can animate output along pipeline paths in your model in the Graph
Results window. This feature can help you understand how your system will
respond when a transient event occurs. You can also animate multiple graphs at
the same time.

Here, you will animate the temperature static, pressure static, and velocity along
the flow path between the positive displacement compressor and Combustion
Basket #1 in order to gain an understanding of how these parameters respond as
the control valve closes.

► Specify the following graph settings (Figure 3.10):

1. Create a new graph tab by clicking the New Tab button located in the
bottom-right (green “+” icon).

2. Select the Profile tab under the Graph Control tab in the Quick Access
Panel.

3. Select Pipes P1 through P5.

4. Ensure the Length Units are meters for the Profile graph.

5. Select the option to Animate Using Output. To use this feature, data from
all pipe stations must be saved (which is the default on the Pipe Sectioning
and Output panel), otherwise the option will be grayed out.

6. Ensure that the Animation Time Units are set to seconds.

7. Add two additional parameters using the Add button, and specify the three
parameters:
a. Temperature Static with units of deg. C

b. Pressure Static with units of bar

c. Velocity with units of meters/sec

8. Check the Mx and Mn boxes next to the graph parameters to plot the
maximum and minimum values on the graph.

9. Click the Generate button.
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Figure 3.10 Graph parameters for Combustion Basket #1 animated profile

Note: The axis titles and scales in Figure 3.11 have been modified to increase
clarity.

Figure 3.11 Flow to Combustion Basket #1 profile animation
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Additional animation control features appear at the top of the Graph Results
window (Figure 3.11). Press the Play button and watch the temperature,
pressure, and velocity responses move between the maximum and minimum
values. This animation can also be recorded to a file.

► Add the graph to the Graph list manager by either right clicking on the graph
or using the Add Graph to List icon. Give it a name, such as "Combustion
Basket #1 Animated Profile".

Playing the animation reveals that the highest temperature in the system is
observed at the J2 heat exchanger. It should also be noted that the rise to this
maximum temperature occurs when the pressure wave from the valve closing
passes through this junction. However, this heightened temperature is not
immediately seen by the combustion baskets downstream because the gas
velocity throughout the system drops immediately following the valve closure.
Instead, the heightened temperature moves slowly downstream until the gas
wave is reflected at the positive displacement compressor and passes through the
heat exchanger going the opposite direction. This causes the local gas velocity to
rise and causes the temperature wave to move downstream towards the
combustion baskets more quickly. This wave eventually reaches Combustion
Basket #1 at around Time = 0.55 seconds, at which point the inlet to the
combustion basket reaches its maximum temperature.

Step 8. Run the other scenarios and graph the results
► Load and run the other two scenarios using the Scenario Manager.

► Observe the Transient Max/Min tab for each scenario, and note the overall
system max static temperature. The max temperature and pressure during both
the steady-state and the transient simulation can also be found at the bottom of
the General tab in the Output. A summary of the system max temperature for
each scenario is shown below in Table 3.2.

Table 3.2 Overall system max static temperatures for the three sectioning
counts

Scenario System Max Transient Temperature (deg. C)
8 Sections 77.6
4 Sections 76.0
2 Sections 75.2

► Create the same graphs from the previous steps for each of the scenarios by
double-clicking on the saved Graph List Items in the Graph List Manager.
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Table 3.3 Combustion Basket max static temperatures for the three sectioning
counts

Scenario

Combustion
Basket #1 Max

Transient
Temperature

(deg. C)

Combustion
Basket #2 Max

Transient
Temperature

(deg. C)

Combustion
Basket #3 Max

Transient
Temperature

(deg. C)
8 Sections 72.3 71.9 60.0
4 Sections 70.7 70.3 60.0
2 Sections 69.6 69.2 60.0

Conclusion

Use of transient conditions within a valve junction allowed us to model the
effects of an unexpected valve closure in a system. The Scenario Manager was
used to easily create variations of the model that analyzed the effect of different
pipe sectioning. While this example was focused on temperature, it also showed
that values such as pressure and velocity can be tracked by xStream. The overall
maximum temperature for the system was found in the Transient Max/Min tab
of the Output, and also at the bottom of the General tab for each scenario (Table
3.2). Different pipe sectioning resulted in different max temperatures (Table
3.3).

Additionally, this example identified the Estimated Maximum Temperature
During Transient as a critical variable in the tabulation of the transient results.
This value sets the boundary for the characteristic grid used by the Method of
Characteristics. If sonic choking occurs at a temperature higher than the
estimated maximum, the model may not converge. As such, this value should be
conservatively high on early runs of a model and then refined once the
temperature that the transient approaches is known.
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C H A P T E R 4

Fluid Library Comparison - Steam Turbine
Shutdown Example

Problem Statement

Two turbines in a high pressure steam system are simultaneously shut down
while a bypass line is opened. Evaluate the maximum pressure at the turbine
inlets. Additionally, quantify the mass flow rate through the bypass valve
throughout the transient and perform an analysis on whether condensation or
two-phase flow occurs in the bypass line. Lastly, conduct a sensitivity analysis
based on the selection of different fluid library data.

Topics Covered
� Using the isometric grid to create a model

� Modeling a transient turbine shutdown

� Creating transient graphs

� Animating profile graphs

� Evaluating the selection of a fluid library

Required Knowledge

This example assumes that the user has some familiarity with xStream such as
placing junctions, connecting pipes, and entering pipe and junction properties.
Refer to the example in Chapter 2 for more information on these topics.

Model File

A completed version of the model file can be referenced from the Examples
folder as part of the xStream installation:

C:\Users\[username]\Documents\Datacor\xStream 4\Examples
� Metric - Fluid Library Comparison - Steam Turbine Shutdown.xtr
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Step 1. Build the model

A. Place the pipes and junctions

Isometric Drawing Mode
The previous example models were drawn using the default Pipe Drawing
Mode, 2D Freeform. xStream has two additional available drawing modes, 2D
Orthogonal and Isometric. In this model, the isometric mode is used to visually
interpret the pipe layout and provide a better understanding of the system.
1. From the Arrange menu, select the option to Show Grid.

2. Open the Arrange menu again, go to Pipe Drawing Mode, and select
Isometric.

3. Place the junctions as shown in Figure 4.1.

4. Click the Pipe Drawing Tool and draw the pipes in the model as shown.
When drawing segmented pipes such as P4 and P5, a red dashed preview
line will show how the pipe will be drawn on the isometric grid. As you are
drawing a pipe, you can change the preview line by clicking any arrow key
on your keyboard or scrolling the scroll wheel on your mouse.

5. Use the Rotate Icons buttons on the Workspace Toolbar, or right-click on
the junction and select the Auto-rotate option to automatically align the
junction with the connected pipes. Alternatively, Customize Icon can be
selected from the right-click menu to manually choose an icon/orientation.

6. The grid can be shown or turned off in the Arrange menu, as shown in
Figure 4.2.

Note: You can hold the "Alt" key while adjusting a pipe by the endpoint to add
an additional segment. This can be used with the arrow key or mouse scroll
wheel to change between different preview line options.

Figure 4.1 Isometric layout with the grid shown
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Figure 4.2 Isometric layout with the grid turned off

B. Enter the pipe and junction data
The system is in place but now the input data for the pipes and junctions needs
to be entered. Double-click each pipe or junction and enter the following data in
the Pipe or Junction Properties window.

All pipe materials are User Specified in this model (see Figure 4.3). Use the
Absolute Roughness of Steel (0.004572 cm) as the Friction Model, along with
the following data:

Note: The pipes below are user defined as they utilize non-standard pipe sizes.

Pipe # Inner Diameter (cm) Length (meters)
1 34 30.5
2 30.5 20
3 30.5 15
4 30.5 4.5
5 30.5 4.5
6 15.5 2
7 10 2
8 15.5 3
9 15.5 1.5
10 15.5 6
11 49 6
12 49 1.5
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Figure 4.3 User Specified Pipe Properties window

J1 - Assigned Pressure
1. Name = High Pressure Steam Inlet

2. Elevation = 0 meters

3. Static Pressure = 170 bar

4. Static Temperature = 570 deg. C

J2 - Area Change
1. Elevation = 0 meters

2. Type = "Conical Transition"

3. Angle (µ) = 45 Degrees

J3, J4, and J7 - Branch
Elevation = 0 meters

J5 and J6 - Assigned Flow
1. J5 Name = Turbine 1

2. J6 Name = Turbine 2

3. Elevation = 0 meters

4. Mass Flow Rate = 228600 kg/hr
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5. Static Temperature = 570 deg. C

6. On the Transient tab of both J5 and J6, enter the following data:

Time
(seconds) Mass Flow (kg/hr)

Static
Temperature

(deg. C)
0 228600 570

0.25 0 570
5 0 570

J8 - Dead End
Elevation = 0 meters

J9 - Bend
Elevation = 0 meters

Type = Standard Elbow (knee, threaded)

J10 and J12 - Bend
Elevation = 1.5 meters

Type = Standard Elbow (knee, threaded)

J11 - Valve
1. Elevation = 1.5 meters

2. Kv = 2600

3. xT = 0.7

4. On the Optional tab, set the Special Condition to Closed

5. On the Transient tab, enter the following data:

Time (seconds) Kv xT
0 0 0.7
2 2600 0.7
5 2600 0.7

J13 - Assigned Pressure
1. Name = Steam Bypass Outlet

2. Elevation = 0 meters

3. Static Pressure = 30 bar

4. Static Temperature = 350 deg. C

C. Check if the pipes and junctions are defined
► Click the List Undefined Objects button to see if the model is fully defined. If

it is not, the undefined pipes and junctions window will show a list of
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incomplete items. If undefined objects are present, go back to the incomplete
pipes or junctions and enter the missing data.

Step 2. Specify Analysis Setup

A. Specify the Fluid panel
► Open the Analysis Setup window from the Common Toolbar and open the

Fluid panel.
► Select Steam from the xStream Standard fluid library, and click the Add to

Model button.

B. Specify the Pipe Sectioning and Output panel
► Open the Pipe Sectioning and Output panel and specify the following:

1. Minimum Number of Sections Per Pipe = 1

2. Estimated Maximum Pipe Temperature During Transient = 600 deg. C

C. Specify the Simulation Mode/Duration panel
► Enter a Stop Time of 5 seconds on the Simulation Mode/Duration panel

from the Transient Control group. Verify the Time Simulation is set to
Transient. Click the OK button.

Step 3. Run the model
► Click the Run Model button on the Common Toolbar or select the option

from the Analysis menu. xStream will prompt you to save the model if you have
not done so already, then will open the Solution Progress window.

Step 4. Graph the results

A. Graph the transient pressures at the turbines
► Go to the Graph Results window. The first graph we will make will show the

Static Pressure at the entrance to the steam turbines.
1. From the Graph Control tab on the Quick Access Panel, select the

Transient Pipe tab
2. Select the Pipe P5 outlet station

3. Ensure that the Time Units are set to seconds

4. Select Pressure Static with units of bar in the Parameters definition area

5. Click Generate

This will generate the graph shown in Figure 4.4. The pressure variation is
difficult to see using the default y-axis scale so we will adjust the scale using the
following steps:
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1. Right-click the y-axis

2. Un-check the Auto Scale box

3. Set the Minimum to 150 bar, the Maximum to 190 bar, and the Major Val
to 10 (see Figure 4.5)

The graph should now match Figure 4.6. When the model contains multiple
transient events, transient pipe graphs allow the user to see the cumulative
impact of the events on system pressure. Note that the first peak contains an
oscillation, which is attributable to the opening of the bypass valve.
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Figure 4.4 Static pressure at steam turbine 2 entrance

Figure 4.5 Axis Modification Window opened by right-clicking the y-axis

70 xStream 4 Quick Start Guide



Figure 4.6 Static pressure at steam turbine 2 entrance with modified y-
axis

B. Animate the bypass line temperature and pressure
We will also animate the profile of the bypass line temperature and pressure in
order to determine whether condensation occurs.
1. Create a new graph tab by clicking the New Tab button located in the

bottom-right (green “+” icon).
2. Select the Profile tab under the Graph Control tab in the Quick Access

Panel.
3. Select pipes 6, 8, 9, and 10.

4. Verify the Length Units are set to meters.

5. Select the option to Animate Using Output. To use this feature, data from
all pipe stations must be saved (which is the default on the Pipe Sectioning
and Output panel), otherwise the option will be grayed out.

6. Ensure that the Animation Time Units are set to seconds.

7. Add two additional parameter using the Add button, and specify the three
parameters:
a. Pressure Static with units of bar

b. Temperature Static with units of deg. C

c. Temperature Saturation with units of deg. C
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8. Make Temperature Saturation a secondary axis parameter by double-
clicking in the empty box to the left of the name. Alternatively, select the
parameter and click the right facing blue arrow above the list of parameters.
If done successfully, the Temperature Saturation parameter should appear
indented under Temperature Static.

9. Uncheck the Mx and Mn boxes only for the Temperature Saturation
parameter.

10. Click the Generate button.

11. Adjust the y-axis scaling for both Temperature Static and
Temperature Saturation as follows:

a. Right-click on the temperature y-axis and uncheck the Auto Scale box

b. Set the Minimum to 300, Maximum to 600, and Major Val to 50.

Important: Ensure both the primary (left) and secondary (right) y-axes
have the same max and min limits when both parameters have the same
unit. This allows for easy visual comparison of the parameters.

12. Click the Play button to review the animation. The animation speed can be
increased by using the Speed Slider at the right side of the playback
controls.

Figure 4.7 Graph Parameters for the bypass line animated profile

Figure 4.8 is useful to determine whether or not condensation occurs in the
system. Condensation can occur by a rise in pressure, a decrease in temperature,
or a combination of both. Each fluid library contains saturation line data and
warning messages will be given in the Output if the fluid properties drop into
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the two-phase region. In this model the temperatures stay well above the
saturation line at all times, showing that the steam is not close to condensing.

Reminder: xStream assumes all gases are superheated and does not model two-
phase flow. Saturation data is only used for predicting the presence of saturation
conditions, and the fundamental equations in the Solver assume the gas is single
phase.

Figure 4.8 Bypass line animation profile

C. Graph the mass flow rate and pressure drop through the
bypass valve
Lastly, we shall create a graph to show the mass flow rate and the pressure drop
through the bypass valve to gain insight into how the flow develops in the
bypass line.
1. Create a new graph tab.

2. From the Graph Control tab on the Quick Access Panel, select the
Transient Jct tab.
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3. In the Select Junctions section, select J11 and click the “>” arrow.

4. Add a second parameter in the Select Parameters section, and specify the
two parameters:
a. Mass Flow Rate Inlet with units of kg/hr

b. Pressure Drop Stagnation Total with units of bar

5. Click the Generate button.

As shown in Figure 4.9, the flow rate increases and the pressure drop decreases
as the valve opens over time. While the observed trends for mass flow rate and
pressure drop are typical for a valve that is opening, it is still worthwhile to
make Transient Jct graphs when multiple transient events occur in order to fully
understand the interactions between them.

Note:Figure 4.9 has modified axes titles and its legend removed for clarity.

Figure 4.9 Bypass valve mass flow rate and pressure drop transient

Step 5. Evaluate the effects of changing fluid libraries

A. Review the results of other libraries
In addition to the xStream Standard fluid library, the model built in this example
was run using Steam from the Chempak, NIST REFPROP, and ASME Steam
libraries. Similar results to the xStream Standard fluid run were obtained for
both the bypass valve and the turbine pressure vs time graph, so these results are
not shown below. Nevertheless, it is sensible to run your system using different
fluid libraries as they have been known to impact results. The temperature
profile for the bypass line showed more significant differences, as is shown
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below comparing the results using NIST REFPROP vs xStream Standard
(Figure 4.10). ASME Steam and Chempak gave nearly identical results to NIST,
and therefore are not shown.

Note that the minimum temperature reached at J11 is about 32 degrees higher in
the xStream Standard fluid library run compared to the NIST REFPROP run.
The results for each fluid library showed that no condensation was found, and no
warnings were given in the Output.

Figure 4.10 Bypass line profile using the NIST REFPROP fluid library

B. Advice for preliminary runs
Obtaining final results from xStream will require multiple iterations. To
effectively work through those iterations, we recommend the iterative process
begins with the following steps:

Step 1: Run the steady-state model with multiple fluid libraries
It is recommended that the first runs are completed using a simplified version of
your model in the Arrow™ Steady-State Solver with each fluid property model
before considering transient conditions. This will allow for larger issues in the
model to be caught before having to commit to Transient runs, which are more
time consuming. This also can inform the types of variables that need to be
considered during refined runs (i.e. if the Arrow™ steady-state runs are close to
the saturation temperature, condensation is a phenomenon that should be
monitored in subsequent runs).
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Step 2: Complete a transient run using an xStream Standard fluid
with minimal sectioning
You should then run your simplified model in the Transient Solver using an
xStream Standard fluid with minimal sectioning (i.e. a lower value for the
Minimum Number of Sections Per Pipe setting on the Pipe Sectioning and
Output panel in Analysis Setup). This is not always possible, such as when
mixtures are present, but this step should always be attempted if allowable. This
will allow for larger issues to be caught before committing to extended run
times. Only after you are satisfied with the model should you attempt increasing
the number of sections.

C. Selection of fluid property model for final runs
A number of factors must be taken into consideration while selecting the fluid
library for an xStream model. If there are no mixtures, and the compound is
present in the xStream Standard library, it is recommended that the xStream
Standard library be the first library used. The xStream Standard fluid library has
the shortest run times of the different libraries and is an excellent choice for
early runs focused on troubleshooting the model. However, if there is a need to
model mixtures, and simplifying the system is not possible, initial runs should
be conducted with NIST REFPROP or Chempak.

NIST REFPROP and Chempak both have greater accuracy than xStream
Standard and can model mixtures; however, both have slower run times.
Chempak typically runs faster than NIST REFPROP with comparable accuracy.
However, Chempak is an optional add-on for purchase while the NIST
REFPROP library comes standard with xStream.

Lastly, ASME Steam provides a well-established, trustworthy source of steam
data. ASME Steam typically has the longest run times, and it is recommended
that a high processing power computer paired with ample time be used to run
your analysis if this library is selected. If either of those elements are
unavailable, it is recommended that one of the other libraries be used, with the
added note that NIST REFPROP is the most similar in accuracy to ASME
Steam.

Table 4.1 summarizes the run times for this example with the different fluid
libraries. The run times will be affected by the specifications of your computer
as well as the memory available. Table 4.1 shows data for runs conducted on the
laptops at Datacor Pipe Flow Modeling as of publication.

Additionally, Table 4.2 provides a library compatibility chart to assist with fluid
property model selection.

It should be noted that if a tremendous amount of accuracy is needed,
appropriate library selection will not be sufficient to give a high accuracy model.
The single parameter that will have the greatest effect on accuracy is the
Minimum Number of Sections per Pipe in the Sectioning panel. Ultimately,
appropriate sectioning remains the single most important factor in creating a
high accuracy model and should be weighed just as heavily as the fluid library
when setting the parameters your transient gas system uses.
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Table 4.1 Comparison of run times with various fluid libraries
Steam Turbine Shutdown Approx Run Times
Fluid Property Model Run Time

xStream Standard - 1 Section 2 - 3 minutes
Chempak - 1 Section 4 - 10 minutes

NIST REFPROP - 1 Section 0.9 - 1.4 hours
xStream Standard - 10 Sections 1 - 2 hours

ASME Steam - 1 Section 3 - 4 hours

Table 4.2 Compatibility chart for fluid library selection for final runs

Fluid
Library

Model Requirements

Mixtures Condensation
Data

Final
Runs

Complex
Systems

xStream
Standard ✔ ✔

NIST
REFPROP ✔ ✔ ✔ ✔

Chempak ✔ ✔ ✔ ✔
ASME
Steam ✔ ✔

Conclusion

Graphs were created showing the turbine inlet pressure over time, and animating
the pressure and temperature in the bypass line. It was determined that no
condensation occurs, regardless of which fluid library was used.

A standard procedure for initial and final runs was discussed:
� Step 1: Run the steady-state model with multiple fluid libraries

� Step 2: Complete a transient run using an xStream Standard fluid with
minimal sectioning

Lastly, a comparison of the different fluid libraries was discussed. The xStream
Standard should be used for initial runs and troubleshooting (runs faster). NIST
REFPROP, Chempak, and ASME Steam libraries should be used for final runs
where higher accuracy is required; however, the trade off is that the model will
have significantly longer run times.
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C H A P T E R 5

Pipe Forces from Turbine Shutdown
Example

Problem Statement

Two turbines in a high pressure steam system have their inlet valves
simultaneously shut off, which causes the system to experience transient forces.
This example describes how to determine the transient force data for the piping
system during the steam flow transient. Additionally, the effect of varying the
valve closure time will be analyzed. Lastly, this example shows how to export
the force results to a force file to use in piping stress software.

Topics Covered
� Calculating the forces associated with a transient event

� Using the Scenario Comparison Tool to compare scenarios

� Exporting force sets to CAESAR II®

Required Knowledge

This example assumes that the user has some familiarity with xStream such as
placing junctions, connecting pipes, and entering pipe and junction properties.
Refer to the example in Chapter 2 for more information on these topics.

Model File

A partially completed model file will be utilized as the starting point for this
example. A completed version of the model file can be referenced if desired.
Both the initial and final model files can be found in the Examples folder as part
of the xStream installation:

C:\Users\[username]\Documents\Datacor\xStream 4\Examples
� Metric - Pipe Forces from Turbine Shutdown - Initial.xtr

� Metric - Pipe Forces from Turbine Shutdown - Final.xtr
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Step 1. Open the model file

For this example, we will be starting from a pre-built model file which has been
partially set up for your convenience. From either the Startup window or the File
menu, browse to the model file with the name shown above, using the variant
with “- Initial” appended to the file name. The Workspace should appear as
shown in Figure 5.1.

Figure 5.1 Model layout

Step 2. Specify the Pipe Sectioning and Output panel
► Open the Pipe Sectioning and Output panel in the Analysis Setup window.

Define the Minimum Number of Sections Per Pipe as 1 section and the
Estimated Maximum Pipe Temperature During Transient as 600 degrees C.
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Figure 5.2 Pipe Sectioning and Output panel

Step 3. Specify the Simulation Mode/Duration panel
► Open the Simulation Mode/Duration panel from the Transient Control

group. Enter the Stop Time as 1 second. Click OK to save and close the
Analysis Setup window.

Step 4. Specify Force Sets
► Open the Force Definitions panel from the Forces group.

We will first add one Force Set from the Workspace.

A. Force Types
The Difference force type is intended to model the specific case where all of the
following criteria is true:
1. The force is between a pair of 90 degree elbows

2. The force is an axial pipe force

3. All pipes, fittings, and components between the elbow pair are in-line

The force equations in the Solver are specific to this geometry. The pipes and
components between the elbow pair can be horizontal, vertical, or sloped, but
the axial component of the fluid weight is not accounted for in the forces.
xStream only accounts for hydraulic forces, or those acting on the pipe from the
fluid. Elevation and hydrostatic pressure are accounted for in the pressure and
flow solution.
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Figure 5.3 Schematic of the Difference force type

The Point force type would be used for calculating the force at a Dead End
junction. It is calculated using the difference in fluid pressure and ambient
pressure, multiplied by the pipe area.

The Difference Exit force type would be used between a single 90 degree elbow
and a location where the fluid is leaving the system, such as an exit valve, exit
orifice, or nozzle.

The force sets in this example will use the Difference force type to calculate the
axial forces between 90 degree elbow pairs.

B. Defining Force Sets
Force sets can be defined from the Workspace, or from within Analysis Setup.

We will first add one Force Set from the Workspace. Generally it is best to
represent each elbow with a unique junction on the Workspace (either an Elbow
or Branch). This example assumes that the static pressure loss in the elbows is
negligible, and therefore, they are modeled as Branch junctions which are
lossless.

► On the Workspace, right-click on Pipe P2 and from the right-click menu
select Create a Force Set with Selected Pipe. Select the Use Pipe Information
radio button and un-check the Include Appended Text option (Figure 5.4). Click
Create. This will open the Force Definitions panel of the Analysis Setup
window. The Force Definitions panel should appear as shown in Figure 5.5.

xStream can only determine axial forces down a pipe in the direction defined as
forward by the force set definition. As such, xStream has no knowledge of the
three-dimensional orientation of a given force set. For example, a vertical pipe
and a horizontal pipe that both have the same force magnitude would be
indistinguishable in xStream. The force set definition informs the sign of the
force, with a positive value indicating a force pushing from the start location to
the end location, and a negative value indicating the converse.

If a more robust view of the 3D orientation of the pipes is required, directional
information can be entered using the optional Force Unit Vector columns. The
Force Unit Vectors do not impact xStream's calculations, but may be useful to
export the output to piping stress analysis software as discussed in Step 10.

Note: Only single pipes can be added as a Difference force set type from the
Workspace.
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Figure 5.4 Adding a force set from the Workspace using the right-click
menu

Figure 5.5 First Force Set added to the Force Definitions panel in the
Analysis Setup window

The remaining force sets will be defined inside the Force Definitions panel.
► Define a force set by clicking New, selecting the Force Type (in this example,

we will be using Difference because all force sets are between 90 degree elbow
pairs), entering a name, and defining the starting and ending locations of the
force set. Set up the force sets as shown in Figure 5.6. Click OK to save and
close the Analysis Setup window.
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1. P2, Difference, P2 Inlet to P2 Outlet (previously created from the
Workspace)

2. P3, Difference, P3 Inlet to P3 Outlet

3. P4, Difference, P4 Inlet to P4 Outlet

► Double-Check Force Set Assumptions: It is important to consider if the force
sets adhere to the assumptions mentioned previously which apply to the
Difference force type. All of the force sets are located between pairs of 90
degree elbows (represented as lossless Branch junctions). Furthermore, each
force set spans a single pipe and there are no branching paths in the middle of
the force sets. Therefore, the defined Difference force sets are valid and
compatible with the equations programmed into xStream.

Note: A Difference force set that spans Pipes P5-P6 would be between a pair of
90 degree elbows, and would be horizontally in-line; however, it would not be
valid since there is a branching flow path in the middle. Even if the flow path
from Pipe P12 to the closed bypass valve starts as stagnant in the steady-state, it
can be affected by the transient, and could potentially serve as an anchoring
support for Pipes P5 and P6. The same applies to Pipe P7, where the Difference
force set would not be valid due to the branching flow at the endpoint.

Figure 5.6 Completed Force Definitions panel in the Analysis Setup
window

Step 5. Create child scenarios using the Scenario Manager

A. Create scenarios
In this model, we will evaluate three different valve closure durations for the
system:
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1. 0.1 Second Valve Closure

2. 0.25 Second Valve Closure

3. 0.5 Second Valve Closure

We will create three child scenarios to model the three cases.
► Go to the Scenario Manager on the Quick Access Panel. Create a child

scenario by either right-clicking on the Base Scenario and then selecting Create
Child, or by first selecting the Base Scenario and then selecting the Create Child
icon. Enter the name "0.1 Second Valve Closure" in the Create Child Scenario
window, and click OK. The new scenario should now appear in the Scenario
Manager on the Quick Access Panel below the Base Scenario.

► Right-click the Base Scenario in the Quick Access Panel. Create another child
and call it "0.25 Second Valve Closure". Finally, create one more child and call
it "0.5 Second Valve Closure". The child scenarios should now be displayed as
shown in Figure 5.7.

Figure 5.7 Scenario Tree with additional child scenarios created

B. Define the child scenarios
Since the "0.1 Second Valve Closure" scenario uses the same transient
definitions as the base scenario, we do not need to modify it. Having a duplicate
of the parent scenario is useful for organizing Multi-Scenario graph selections
and keeping your scenario tree intuitive. We will set up the remaining scenarios
using the following steps:
1. Load the "0.25 Second Valve Closure" scenario by double-clicking the

name in the Scenario Manager.
2. Open the Assigned Flow Properties window for Assigned Flow J10 and

open the Transient tab. Enter the following data:

Time
(seconds)

Mass Flow
(kg/sec)

Static Temperature (deg.
C)

0 62.75 570
0.25 0 570

1 0 570

3. Enter the same Transient Data for Assigned Flow J12.

4. Open the Child Scenario "0.5 Second Valve Closure" from the Scenario
Manager.

5. Open the Assigned Flow Properties window for Assigned Flow J10 and
open the Transient tab. Enter the following data:
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Time
(seconds)

Mass Flow
(kg/sec)

Static Temperature (deg.
C)

0 62.75 570
0.5 0 570
1 0 570

6. Enter the same Transient Data for Assigned Flow J12.

Step 6. Compare child scenarios using the Scenario Comparison Tool

The three scenarios created should be identical except for the different transient
data. To confirm the scenarios are otherwise identical, we will use the Scenario
Comparison Tool.
1. Load the "0.1 Second Valve Closure" scenario from the Scenario Manager.

2. In the Tools menu, select the Scenario Comparison Tool.

3. In the Scenario Comparison - Selection window (Figure 5.8), select the
Siblings option.

4. Click Show Comparison.

5. In the Scenario Comparison Grid, set the Item and Parameter sliders to
show Differences. Also set the Highlight Unique Values slider to Yes.

The Scenario Comparison Tool will run a comparison of all Pipe and Junction
Properties as well as the General Properties used in each scenario and highlight
any differences in the Scenario Comparison Grid. In this model, the only
highlighted differences should be for the First Transient Data parameter for
junctions J10 and J12 (Figure 5.9). Note that each column in the Scenario
Comparison Grid is highlighted in a different color. This indicates that each
scenario possesses a unique value for the given parameters. Click close to exit
the Scenario Comparison Tool.

Figure 5.8 Scenario Comparison Tool - Selection window
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Figure 5.9 Scenario Comparison Grid of the sibling scenarios

Step 7. Run the first scenario
► Double-click the "0.1 Second Valve Closure" child scenario in the Scenario

Manager. Select Run Model from the Analysis menu. This will open the
Solution Progress window. Once finished, click Output on the Solution Progress
window.

Step 8. View the results

A. Open the Forces tab
► In the Output window, click on the Forces tab. This will show the maximum

force observed in the defined force sets, as well as provide information about
how the force segments were defined.

Figure 5.10 Forces tab in the Output window for the "0.1 Second Valve
Closure" scenario

B. Graph the force results
► Open the Graph Results window. We will create a graph that shows the

transient forces over time for the force sets. To do so, perform the following
steps:
1. Select the Forces tab on the Graph Control tab on the Quick Access Panel,

as shown in Figure 5.11.
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2. Click the All button such that all force sets are selected from the list to be
graphed.

3. Verify the Force Units Primary Y is set to N.

4. Verify that Time Units is set to seconds.

5. Verify that the Time Frame is set to All Times.

6. Click Generate.

This should generate the graph shown in Figure 5.12.

Add the graph to the Graph List Manager by right-clicking the graph results
window and selecting "Add Graph To List...", or by using the icon on the
toolbar. Name the graph "Force Sets" and click OK.

Figure 5.11 Graph parameters for force sets

Figure 5.12 Force vs Time graph for the "0.1 Second Valve Closure"
scenario
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Note that at Time = 0 seconds, there are no forces for any of the force sets. This
is expected since the sum of forces across a piping run between two elbows
equals zero in a steady-state system. If a Point or Exit type force set were used
instead of a Difference type force set, then a non-zero force may be encountered
during the steady-state.

Additionally, some traditional methods of analyzing force sets will not yield the
same results as xStream since they may not include friction or momentum
effects in their force balances. Traditional methods can yield significantly
different results and indicate incorrect, non-zero forces during steady-state
conditions.

There are two important points to be observed here:
1. xStream calculates transient fluid forces. This does not include weight from

piping, components, or the fluid itself, or any other forces external to the
piping. A comprehensive analysis of pipe loading must separately include
these items.

2. Ignoring friction and momentum force balance components will result in
force imbalances that do not exist in reality.

Step 9. Run the other child scenarios
► Run the other two child scenarios and load the Force Sets graph list item

for each. The results are shown in the figures below.

Figure 5.13 Forces tab in the Output window for the "0.25 Second Valve
Closure" scenario
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Figure 5.14 Force vs Time graph for the "0.25 Second Valve Closure"
scenario

Figure 5.15 Forces tab in the Output window for the "0.5 Second Valve
Closure" scenario

Figure 5.16 Force vs Time graph for the "0.5 Second Valve Closure"
scenario
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These figures show that the maximum force magnitude increases as the valve
closes faster. Typically, the more rapidly a change occurs, the more severe the
resulting forces are. Therefore, a utility of xStream would be to evaluate the
correlation between transient event duration (e.g., valve closing time) and the
resultant force magnitudes.

Factors affecting the timing and magnitude of forces
The pipe sectioning, fluid property model, and specification of the Maximum
Pipe Mach Number During Transient setting can have a significant effect on the
accuracy of the forces calculated by xStream. These effects are not significant
for the system built within this example. However, the results for altering each
of these three parameters are shown in the figures below so that you may see the
impact of changing these three parameters. Note that in Figure 5.18, Steam from
the ASME Steam, Chempak, and NIST REFPROP fluid libraries are
superimposed on each other, indicating no meaningful difference for this case.

Figure 5.17 Effect of sectioning when all scenarios use the xStream
Standard fluid library and a Maximum Pipe Mach Number
During Transient of 1

90 xStream 4 Quick Start Guide



Figure 5.18 Effect of the fluid property model when all scenarios use a
Minimum Number of Sections Per Pipe of 1 and an Estimated
Maximum Pipe Mach Number During Transient of 1
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Figure 5.19 Effect of Maximum Pipe Mach Number During Transient when
all scenarios use the xStream Standard fluid library

Step 10. Export to a CAESAR II Force File
► Open the Output window, and click on the File menu. Select Export Force

File... and choose CAESAR II® Force File. This will open the export file
window shown in Figure 5.20.
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Figure 5.20 Export CAESAR II® Force File window

The force sets to include in the force file may be individually selected, along
with how frequently data points are saved. The number of data points that will
be in the file is also displayed for the given settings. This number should not
exceed the maximum number of data points allowed for the relevant piping
stress software, which in the case of CAESAR II® is 2500.

If unit vector information has been entered in the Force Definitions panel, the
Export Unit Vector option can be used to include this information in the
exported file. Similar methods to those described above can be used to export
force files to ROHR2®, TRIFLEX®, and AutoPIPE®.

Conclusion

Force sets were defined to calculate the transient forces between pairs of 90
degree elbows (represented by lossless Branch junctions) as a result of two
simultaneous Turbine Safety Valve closures in a steam system. Several child
scenarios were created to evaluate the effect of the closure time where we noted
that a faster valve closure produced higher magnitudes of forces. Several
important assumptions and takeaways were discussed:
1. The Difference force type is intended to model the specific case where all

of the following criteria is true:
a. The force is between a pair of 90 degree elbows

b. The force is an axial pipe force

c. All pipes, fittings, and components between the elbow pair are in-line

2. xStream calculates transient fluid forces. This does not include weight from
piping, components, or the fluid itself, or any other forces external to the
piping. A comprehensive analysis of pipe loading must separately include
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these items.
3. Ignoring friction and momentum force balance components will result in

force imbalances that do not exist in reality.

Finally, we discussed how to export these forces into a force file to be used in
pipe stress analysis software.
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C H A P T E R 6

xStream PFA Add-on Module Example -
Frequency Analysis

Problem Statement

The preliminary design for a system uses a positive displacement reciprocating
compressor that is single-acting and has two heads (cylinders) with a 180 degree
phase offset. It is suspected that the design may have pulsation resonance issues
and needs to be checked for compliance with the API 618 standard. Perform a
frequency analysis by placing a forcing function on the PD compressor and
observing the frequency response of the system. Determine the worst acoustic
natural frequency of the system, run the compressor at the worst-case RPM, and
determine if the API 618 limits are violated.

Topics Covered
� Using the PFA Module to identify natural acoustic frequencies

� Defining valid sectioning and simulation duration settings for pulsation
analysis

� Identifying problematic compressor speeds based on pulsation frequency and
cylinder arrangement

� Using periodic flow to represent a reciprocating compressor

� Checking API 618 compliance

Required Knowledge

This example assumes that the user has some familiarity with xStream such as
placing junctions, connecting pipes, and entering pipe and junction properties.
Refer to the example in Chapter 2 for more information on these topics.
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Model File

A completed version of the model file can be referenced from the Examples
folder as part of the xStream installation:

C:\Users\[username]\Documents\Datacor\xStream 4\Examples
� Metric - Frequency Analysis - PFA.xtr

Step 1. Activate the PFA module

Open the Analysis Setup window and go the Modules panel under the Modules
group. Then, select the option to Activate PFA.

Step 2. Build the model

A. Place the pipes and junctions
The next step is to define the pipes and junctions. In the Workspace window,
assemble the model as shown in Figure 6.1.

Figure 6.1 Layout of frequency analysis model

B. Enter the pipe and junction data
The system is in place but now we need to enter the input data for the pipes and
junctions. Enter the following data:

All Pipes are Steel - ANSI, STD (schedule 40), and have standard roughness.
The rest of the pipe information is as follows:
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Pipe # Length (meters) Size (inches)
1 8 10
2 8 10
3 8 10
4 80 16
5 3 6

J1 - Assigned Flow
1. Name = PD Compressor

2. Elevation = 3.5 meters

3. Mass Flow Rate = 2 kg/sec

Note: This is the average bulk flow produced by the compressor.

4. Temperature = 38 deg. C

J2 - Valve
1. Elevation = 3.5 meters

2. Loss Source = User Specified

3. Loss Model = Kv

4. Kv = 385

5. xT = 0.8

J3 - Branch
Elevation = 3.5 meters

J4 - Valve
1. Elevation = 0 meters

2. Loss Source = User Specified

3. Loss Model = Kv

4. Kv = 1380

5. xT = 0.6

J5 - Assigned Pressure
1. Elevation = 0 meters

2. Stagnation Pressure = 0 barG

3. Temperature = 38 deg. C
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J6 - Dead End
1. Name = Closed Valve

2. Elevation = 3.5 meters

C. Check if the pipe and junction data is complete
► Turn on List Undefined Objects from the Main Toolbar to verify if all data is

entered. If it is not, the undefined pipes and junctions window will show a list of
incomplete items. If there are undefined objects, go back to the incomplete pipes
or junctions and enter the missing data.

Step 3. Specify Analysis Setup

A. Fluid panel
► Open the Analysis Setup window and select the Fluid panel under the Fluid

Properties group.
► Select Methane from the xStream Standard fluid library, and click the Add

to Model button.

B. Pipe Sectioning and Output panel
► Open the Pipe Sectioning and Output panel and define the following

settings: in
1. Minimum Number of Sections Per Pipe = 8 sections

2. Estimated Maximum Pipe Fluid Temperature During Transient = 65 deg. C

C. Simulation Mode/Duration panel
► Enter a Stop Time of 2 seconds on the Simulation Mode/Duration panel in

the Transient Control group.

D. Pulsation Frequency Analysis panel
► Open the Pulsation Frequency Analysis panel from the Pulsation Setup group.

The Pulsation Frequency Analysis panel is used to specify the location and
magnitude of the pulse applied to the system, as well as the parameters required
to generate the forcing function for frequency analysis.

► Define the Pulsation inputs as follows (Figure 6.2):

1. Select Natural Frequency Evaluation for the Frequency Analysis Mode.

2. Select junction J1 as the location for the pulse to be applied at.

3. Under Frequency Domain, ensure the Minimum Number of Frequency
Samples is set to the default value of 1000, and define the Cutoff
Frequency as 200 Hz.

4. In the Advanced Settings, ensure the Pulse Magnitude is set to Automatic
(Twice Steady-State Flow).
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Figure 6.2 Pulsation Frequency Analysis panel in the Analysis Setup
window with all pulsation settings defined

Now that all of the pulsation inputs are defined, look at the Pulsation Summary
in the Pulsation Frequency Analysis panel. The defined Cutoff Frequency and
the Minimum Number of Frequency Samples will affect the number of sections
and the simulation duration that are required to run the analysis. If the number of
sections is insufficient, then the time step will be too large to capture the
specified Cutoff Frequency. Similarly, if the simulation duration is too small,
then the number of time steps will not accommodate the Minimum Number of
Frequency Samples.

Checking the Pulsation Summary for this example, the Minimum Sections
Required for Cutoff are 2, and the Minimum Simulation Duration Required for
Min. Samples is 0.79 seconds. Both of these requirements are satisfied by the
current model settings. The Meet Min. Requirements button can be used to
automatically change the minimum number of sections and/or the minimum
simulation duration if they are insufficient. Click OK to save and close the
Analysis Setup window.

Step 4. Run the model
► Select Run Model from the Common Toolbar. This will open the Solution

Progress window. This model has an estimated run time of several minutes, but
the run time is dependent on the speed of your PC.
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Step 5. Ensure the pressure response stabilizes
► Open the Graph Results window. The first step will be to generate a plot of

the pressure in each of the pipes to ensure that the simulation duration was long
enough for the response to stabilize.

► Create the pressure graph as follows:

1. Select the Transient Pipe tab from the Graph Control tab of the Quick
Access Panel

2. Add the Inlet and Outlet station for each of the pipes

3. Choose Pressure Static as the Parameter in units of bar

4. Click Generate

The pressure graph should appear as shown in Figure 6.3. Note that there is a
small perturbation in the pressure when the pulse is applied to the system,
though the pressure results completely stabilize by the end of the run. If the
pressure results were still changing at the end of the run, the model should be re-
run with a longer simulation duration.

Figure 6.3 Static Pressure vs Time in each pipe shows that the
Simulation Duration is sufficient

Step 6. Graph the frequency response
► Next, graph the acoustic frequency response as follows:
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1. Click the New Tab button (green “+” icon in the bottom-right)

2. Select the Frequency tab in the Graph Parameter section of the Quick
Access Panel (Figure 6.4)

3. Add the Inlet and Outlet station for each of the pipes

4. Verify that the pressure units are set to bar

5. Click the Generate button

Figure 6.4 Graph Parameters section for the frequency analysis

Identify excitation frequencies to study
From the graph in Figure 6.5, there are several frequencies that produce a large
pressure response. Points on the plot with a large response magnitude are easily
identified by finding local maxima on the graph. The frequency and amplitude
associated with these maxima can be highlighted on the graph by clicking and
dragging the cursor from left to right highlighting the location of the local
maximum. These maxima are the acoustic natural frequencies that are
potentially the most damaging when excited by a positive displacement
compressor. These frequencies can also be caused by equipment that contributes
large pressure drops, such as control valves.

Two natural frequencies are identified for the system based on the peaks in the
graph at roughly 28 Hz and 56.5 Hz. Note that the number of sections used for
the analysis may affect the location of the peaks, so it is prudent to run the
analysis with more sections to reduce uncertainty in the results. It is also
recommended to analyze frequencies near identified peaks (for example,
analyzing 55 and 56 Hz for the peak at 56 Hz) to account for potential shifting
of the frequency peaks that can result from the assumptions made for the
frequency analysis in xStream.
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Figure 6.5 Acoustical frequency graph for the positive displacement
compressor system

Step 7. Simulate the worst-case scenario

A. Determine the worst-case RPM
The 28 Hz excitation frequency resulted in the highest magnitude pressure
response for the system; therefore, it will be the focus for the remainder of this
example. In order to run a worst-case scenario, we need to translate the
excitation frequency to a compressor speed in RPM. The equation below relates
compressor RPM and the number of heads (N) to the fundamental frequency,
also called the base pulsation frequency (fb), and only applies when the
number of heads is even and equally offset.

In this case 28 Hz pulsation frequency corresponds to 840 RPM. We will use
this RPM in the next step. A real analysis might also include lower speeds that
have a harmonic multiple falling on an excitation frequency of the system, such
as 420 RPM, if these speeds are near the desired operating speed of the
compressor.

B. Create a scenario with Steady State Pulsation
► Create a child scenario and switch to Steady State Pulsation analysis mode:
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1. In the Scenario Manager, right-click on the Base Scenario and choose
Create Child. Name the child scenario “840 RPM”.

2. Open the Analysis Setup window and go to the Pulsation Frequency
Analysis panel.

3. Switch the Frequency Analysis Mode to the Steady State Pulsation option.

4. Under the Pulsation Source section, select the Reciprocating Compressor
option. The Compressor dropdown menu will show User Defined since this
example is using an Assigned Flow junction to represent the discharge of
the compressor.

5. Enter the Speed as 840 RPM and the Number of Heads as 2.

6. Ensure the checkbox for Evaluate with API 618 is enabled. Click OK to
save and close Analysis Setup.

C. Approximate the compressor flow
Since the PD compressor is single-acting and has 2 compression cylinders with a
180 degree phase offset, we can take advantage of the Periodic Flow option in
the Assigned Flow junction to create a modified sine wave that approximates the
mass flow leaving the compressor. In this case, having 2 heads with a 180
degree offset results in an easy, symmetrical chopped sine wave with two peaks
per period.

The Periodic Flow with Chopped Sine Wave option will require a frequency and
amplitude. For the Chopped Sine Wave sub-option, the frequency represents two
peaks. It is equivalent to taking the absolute value of a full period of a normal
sine wave. Assuming that the minimum flow that occurs between the peaks is
zero, the flow amplitude must scale the steady-state flow rate by π/2 to achieve
an equivalent bulk flow rate. This is shown in Figure 6.6 for one crankshaft
rotation, and the areas under the steady-state and periodic mass flow curves are
equal to the other. This scaling results in a flow amplitude of 3.14 kg/sec.
Because the compressor flow has two peaks per crankshaft revolution, the
frequency of the sinusoid is equal to the frequency of the crankshaft, which at
840 RPM is 14 1/s (Hz).
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Figure 6.6 Illustration of transient and steady mass flow rates with
identical areas under the curves, resulting in equivalent bulk
flow rates

► Modify the Assigned Flow junction to represent steady-state pulsation:

1. Open the Assigned Flow Properties window for junction J1.

2. In the Flow Model tab, set Mass Flow Rate to 0.01 kg/s. This is chosen to
be near zero since the Assigned Flow junction does not accept an input
steady-state flow of zero.

3. In the Transient tab, clear the pulse transient data by clicking Edit Table
under the transient table and choosing Clear All Data.

4. Check the boxes next to Periodic Flow and Chopped Sine Wave.

5. Set the Frequency to 14 1/s.

6. Set the Flow Amplitude to 3.14 kg/sec (Figure 6.7).

7. Click OK to save and close the Assigned Flow Properties window.
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Figure 6.7 Assigned Flow Properties window with Periodic Flow
transient applied

The model is now updated to represent the pulsation at the positive displacement
compressor that will excite the system.

Step 8. Check for compliance with API 618

A. Check the Output for warnings
► Run the model, then navigate to the Output window.

A warning will be shown stating that the maximum pressure limit for API 618
was exceeded as is shown in Figure 6.8. The caution message stating that
lowering the estimated maximum pipe Mach number may increase accuracy is
useful for improving sectioning, but iterating on this value is not necessary for
the purpose of this example. The caution message about the maximum transient
pipe Mach number exceeding the steady pipe Mach number can be ignored,
since this is to be expected based on the flow amplitude.

When the API 618 evaluation is performed, the Pulsation Summary tab is shown
in the Output window with additional information on where pressure limit
violations occurred, and what inputs were used to calculate the API 618 pressure
limits for the scenario (Figure 6.9).

105 xStream 4 Quick Start Guide



Figure 6.8 Warning showing that the API 618 pressure limits have been
exceeded at multiple locations

Figure 6.9 Pulsation Summary tab listing the pipes with the largest API
618 pressure violations

B. Examine the pulsation at the compressor
The pulsation behavior at the outlet of the compressor can be illustrated by
graphing the flow at the inlet of Pipe P1.
1. Select the Transient Pipe tab in the Graph Parameter section of the Quick

Access Panel
2. Add the Inlet station from Pipe P1

3. Select Mass Flowrate as the graphing parameter with units of kg/sec

4. Ensure that Time Units are set to seconds

5. Click the Generate button

6. Right-click on the x-axis and uncheck the Auto Scale option

7. Set the Maximum to 0.286, which corresponds to 4 crankshaft rotations

8. Set the Major Val to 0.0714, which is the period of a single crankshaft
rotation (60/840)

The resulting graph is shown in Figure 6.10. There should be 8 pulses each with
a maximum flow near 3.14 kg/sec and a minimum flow near zero. The period of
each pulse (a single peak on the graph) is equal to 0.0357 seconds, which
translates to a pulsation frequency of 28 Hz. Being equal to the first major
natural frequency of the system, this should result in maximum excitation of the
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pressure amplitude in the system at this frequency and its associated harmonic
integer multiples.

Figure 6.10 Periodic mass flowrate supplied by the compressor over 4
crankshaft revolutions

C. Graph the API 618 limits
There were many locations within the model where the API 618 limits were
exceeded. Since this example focused on the closed valve at the J6 Dead End,
we will graph the API 618 limits for this location. The same procedure could be
applied for any location in the model.
1. Select the Frequency tab in the Graph Parameter section of the Quick

Access Panel
2. Add the Pipe P5 Outlet station

3. Ensure the Pressure Units are set to bar

4. Click the Generate button

Figure 6.11 shows the resulting graph in which xStream has overlaid the
calculated API 618 limits. A noticeable spike is seen at 28 Hz which exceeds the
API 618 limit for the outlet station. Keen observers will notice very small spikes
at the harmonic multiples of the compressor frequency (56 Hz).
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Figure 6.11 Frequency graph showing the API 618 limits

Because the peak-to-peak pulsation level recommended by API 618 is exceeded,
the system design may need to be changed in order to minimize vibration and
maximize system longevity. This could be achieved by changing the compressor
selection such as one with more cylinders or replacing the compressor with
several smaller capacity compressors. Other approaches may include changing
pipe geometry or adding pulsation suppression devices such as acoustic filters,
pulsation bottles, finite volume surge tanks, or choking tubes.

Conclusion

The PFA Add-on Module for xStream can be used to apply a pressure pulse to
the system in order to identify acoustic frequencies which may result in damage.
These frequencies can be used in further pulsation analysis to determine if
pulsation mitigation is required. The Steady State Pulsation analysis mode and
Assigned Flow junction with a periodic chopped sine wave allowed us to
simulate the PD compressor running at a specified RPM.

The piping layout and geometry of the system was found to have an excitation
frequency of 28 Hz (the first harmonic). With a single-acting, 2 head, 180
degree phase offset compressor, the fundamental frequency or base pulsation
frequency of 28 Hz corresponded to a compressor speed of 840 RPM. The
compressor outlet flowrate was approximated with a chopped sine wave where
the frequency was 14 Hz. The two peaks per period represented the flow from
each compression cylinder during one full rotation of the crankshaft.

The peak-to-peak pressure oscillations were found to violate the API 618
standard. Future modifications would need to be made to the system such as
changing the compressor, altering the piping layout, or utilizing pulsation
suppression devices.
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C H A P T E R 7

Other xStream Capabilities

This Quick Start Guide necessarily omitted or had brief coverage of a number of
important xStream capabilities. This chapter briefly describes some of the
important capabilities not covered.

Microsoft Excel® data integration

xStream includes Excel importing and exporting. An Excel spreadsheet can be
used to vary selected input parameters in multiple scenarios. Selected output can
also be exported to specified Excel sheets and cells.

Integration with other software and data standards

xStream includes a number of importing and exporting capabilities. Piping
layouts and dimensional data can be imported from GIS Shapefiles (*.SHP) to
build a model. CAESAR II Neutral Files (*.CII) can be imported into xStream
and EPANET Files (*.INP) can be both imported and exported. Additionally,
force files can be exported for use in CAESAR II®, TRIFLEX®, ROHR2®, and
AutoPIPE®.

Piping Component Files (*.PCF) from AutoCAD Plant 3D®, SmartPlant®,
PDS®, CADWorx®, and other software can be imported into xStream. These
options are all accessed from the File menu.

Convective heat transfer

Besides the default adiabatic heat transfer model, pipes can be modeled using
convective heat transfer, convective heat transfer with heat flux, or convective
heat transfer with heat tracing. When any of the convective heat transfer models
are selected conductive heat transfer in the fluid and pipe walls will be
accounted for both radially and axially, well as accounting for convective heat
transfer at the pipe wall surfaces.
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Gas mixtures using NIST REFPROP and Chempak

NIST REFPROP and Chempak allow user-created gas mixtures using any of the
pure fluid data provided in their databases. xStream is restricted to non-reacting
gas mixture calculations.

The ASME Steam Tables library

The ASME Steam Tables library offers users access to fluid properties obtained
from the IAPWS Industrial Formulation 1997 for the Thermodynamic Properties
of Water and Steam (ISPWS-IF97). This library is selected by choosing the
option at the top of the Fluid panel in the Analysis Setup window, at which point
it is automatically displayed in the Fluids in Current Model area.

Sonic choking

xStream models sonic choking in complex pipe systems and accurately predicts
the resulting choked flow rate during both the steady state and transient
simulation. In addition, xStream can accurately calculate multiple choking points
in the system.

Positive displacement compressors

xStream can model positive displacement compressors. Typically PD
compressors are modeled as a known flowrate over time. Complicated periodic
flowrates from multiple pistons and/or multiple out of phase compressors can
also be modeled.

Flow and pressure control valves

xStream can model flow and pressure control valves. xStream accounts for
control valves which lose and regain control during the transient.

Relief valves

The Relief Valve junction allows for a non-reclosing style relief device to be
modeled. The loss through the relief valve can be represented using orifice sizes
from API 526.

Repeat transient feature for periodic transient behavior

For elements which have periodic behavior (such as positive displacement
compressors), one cycle of data can be entered and then specified to repeat once
the cycle is finished.
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Elevation changes

xStream uses elevation differences between junctions to calculate hydrostatic or
gravity pressure changes in a system. This can be especially useful for high
density gases with moderate elevation changes or pipe systems with significant
elevation changes such as those found in overland natural gas pipelines, gas
piping for deep mining operations, and HVAC in high rise buildings.

Fitting library

xStream offers a library of about 400 fitting losses which can be added to pipes.

Design alerts

Design Alerts can be entered for pipes, then cross-plotted vs. system behavior. A
common use is maximum allowed operating pressure.

Libraries

Junction components and pipe materials can be saved to libraries for later reuse.
Libraries can be located on local PCs or deployed across local or wide area
networks. The Library Manager allows users to connect to relevant libraries for
their specific pipe system design.

Workspace Layer animations

The Workspace Layers provides the ability to animate the transient results as a
qualitative tool to visualize the behavior in a network. One parameter can be
animated using absolute values, values relative to the steady-state, or a static
map of all maximum/minimum transient values can be generated. The animation
can also be recorded to a file.

Compare input from different scenarios

The Scenario Comparison Tool can be used to compare pipe, junction, and
general model file inputs for any number of scenarios in the model file. This
allows the user to quickly identify differences between scenarios, or to generate
a report on inputs for different cases.
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